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About this document

This document is a guide to defining, configuring and maintaining service 
data for a Passport node.

The following topics are discussed in this section:

• “Who should read this document and why” (page 13)

• “What you need to know” (page 13)

• “How this document is organized” (page 14)

• “What’s new in this document” (page 15)

• “Text conventions” (page 15)

• “Mouse function reference” (page 16)

• “Common dialogs” (page 17)

• “Using the keyboard and online help” (page 17)

• “Related documents” (page 19)

Who should read this document and why
This document is intended for persons responsible for defining, configuring, 
and maintaining service data for a Passport node. Persons who install and 
engineer the Passport network can also use this guide.

What you need to know
Before you read this document, you need to be familiar with how to logon to 
the Preside Multiservice Data Manager (MDM) workstation and how to work 
with the user interface. An understanding of the Passport network and service 
data ia also helpful.
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How this document is organized
This guide introduces the tools for Configuration for Passport Devices and 
how to start them. Subsequent sections provide information on using the 
various applications and Preside Multiservice Data Manager (MDM) tools. 

241-6001-023 Preside MDM Configuration Management for Passport User 
Guide contains the following sections:

• “Introducing Configuration for Passport Devices” (page 21) briefly 
describes the tools in the Passport Devices Configuration toolset.

• “Starting Configuration for Passport tools” (page 27) describes the steps 
involved in logging on to an MDM workstation and accessing a 
particular application.

• “Software Download and Configuration” (page 35) describes how the 
Software Distribution and Configuration application is used to upgrade, 
configure, and download software to nodes in the network.

• “Network Activation” (page 81) describes how the Network Activation 
tool is used to automate the activation process.

• “Global Data Manager” (page 135) describes how the Global Data 
Manager command line tool is used to propagate global service data from 
a node to other selected nodes and to replace attribute values.

• “Using HP OpenView NNM desktop” (page 149) describes how you can 
access the Passport Devices configuration tools from the HP OpenView 
NNM desktop application.

For information on the nodal and service provisioning tools, see the 
following:

• for the Nodal Provisioning tool, see 241-6001-610 Preside MDM Nodal 
Provisioning User Guide and 241-6001-611 Preside MDM Nodal and 
Service Provisioning Reference Guide

• for Service Provisioning - ATM, see 241-6001-600 Preside MDM 
Service Provisioning for ATM User Guide

• for Service Provisioning - Frame Relay, see 241-6001-603 Preside MDM 
Service Provisioning for Frame Relay User Guide
241-6001-023   15.1RSUP   
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For information on the Passport/SNMP Service Data Backup/Restore tool, 
see 241-6001-807 Preside MDM Network Backup and Restore.

For information on the Inventory Reports tool, see 241-6001-808 Preside 
MDM Device Inventory Tools User Guide.

For information on the Network Reporting System, see 241-6001-022 
Preside MDM Network Reporting System User Guide.

What’s new in this document
Passport Component Provisioning content was removed from this document 
in MDM 15.1.

Text conventions
This document uses the following text conventions: 

• nonproportional spaced plain type

Nonproportional spaced plain type represents system generated text or 
text that appears on your screen.

• nonproportional spaced bold type

Nonproportional spaced bold type represents words that you should type 
or that you should select on the screen.

• italics

Statements that appear in italics in a procedure explain the results of a 
particular step and appear immediately following the step.

Words that appear in italics in text are for naming.

• [optional_parameter]

Words in square brackets represent optional parameters. The command 
can be entered with or without the words in the square brackets.
Preside MDM Configuration Management for Passport User Guide   15.1RSUP
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• <general_term>

Words in angle brackets represent variables which are to be replaced with 
specific values.

• UPPERCASE, lowercase

Uppercase and lowercase letters that appear in UNIX commands and 
parameters must be matched exactly. The system matches upper and 
lowercase characters differently.

• |

This symbol separates items from which you may select one; for 
example, ON|OFF indicates that you may specify ON or OFF. If you do 
not make a choice, a default ON is assumed.

• ...

Three dots in a command indicate that the parameter may be repeated 
more than once in succession.

The term absolute pathname refers to the full specification of a path starting 
from the root directory. Absolute pathnames always begin with the slash ( / )
symbol. A relative pathname takes the current directory as its starting point, 
and starts with any alphanumeric character (other than /).

Mouse function reference
When we want you to press and release the mouse button, we refer to it as 
clicking. Depending on the action to be taken, the text will read “click select” 
or “click modify”.

When you access a menu, you need to press and hold the mouse menu button 
down. After you select the menu option, you can release the mouse button. 
The text will read “press menu”.

The Select and menu mouse buttons also have window manipulation 
functions. See 241-6001-802 Preside MDM User Interface Primer.
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Common dialogs
All Passport Devices configuration tools share dialogs that prompt you for 
action in the event of certain errors, questions, and warnings and in the 
processing of certain tasks.

Error dialog
There is an error. Click OK to close the dialog. 

Question dialog
You need to respond before you can proceed. Click Yes to perform the action 
requested. Click No to proceed without performing the action requested. 

Warning dialogs
You need to respond before you can proceed. Click OK to close the dialog. 

Processing dialogs
Click Stop to confirm that you want to stop the task in progress. 

Using the keyboard and online help
The following sections provide help on using the keyboard and the online 
help facilities in Configuration for Passport Devices.

Help on Keys
You can use the keyboard instead of the mouse to perform the default action 
in a dialog, to select a menu function, or to execute a command using a 
command shortcut. 

Performing the default action
Some dialogs have a default (live) action button distinguished from the other 
buttons by the extra box around it. You can perform the default action by 
pressing the Enter key anywhere in the dialog. 

Selecting a menu function
You can use mnemonics to perform any of the functions available from the 
menu bar. Mnemonics are single characters that uniquely identify a menu 
item. The mnemonic for each menu item is identified by an underscore. 
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You can use a mnemonic by pressing the F10 key and then entering the 
mnemonic string for the menu function you want to use. You can press the 
meta key and the mnemonic for the menu you want to access, followed by the 
mnemonic for the specific menu function. 

For example, to invoke the Authenticate (mnemonic A) function on the 
Options (mnemonic O) menu, use either of the following key sequences: 

• F10 O a 

• Meta-O A 

Using command shortcuts
The tool provides the following command shortcuts:

• CTRL-E to exit from the tool 

• Meta-H to display help information for the dialog, menu item, or button 
that the cursor is currently on. When you press Meta-H, the cursor 
changes to a question mark symbol. Move the cursor to the item for 
which you want help. Press the Select button to display help information 
for the item. 

Help on Help
One set of help information describes the anchor window. It gives a brief 
overview of the tool and has subsections that describe key parts of the main 
window. You can view it by pulling down the Help menu and selecting the On 
Window option. 

Help for each menu is also available from the last entry on each menu, 
appropriately labelled Help. 

One set of help information is available for each major dialog of the user 
interface. You can view the help information for a dialog by clicking the Help 
button for that dialog. 

The Context Help button changes the mouse cursor into a question mark 
symbol. You then slide the cursor over the component for which you want to 
get help, and press the Select mouse button. 
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Related documents
See the following documents for related information:

• 241-6001-011 Preside MDM Fault Management User Guide

• 241-6001-012 Preside MDM Configuration Management for DPN User 
Guide

• 241-6001-022 Preside MDM Network Reporting System User Guide

• 241-6001-304 Preside MDM Configuration Management for DPN 
Administration

• 241-6001-600 Preside MDM Service Provisioning for ATM User Guide

• 241-6001-603 Preside MDM Service Provisioning for Frame Relay User 
Guide

• 241-6001-610 Preside MDM Nodal Provisioning User Guide

• 241-6001-611 Preside MDM Nodal and Service Provisioning Reference 
Guide

• 241-6001-807 Preside MDM Network Backup and Restore

• 241-6001-808 Preside MDM Device Inventory Tools User Guide

• NN10600-270 Nortel Networks Multiservice Switch 7400/15000/20000 
Software Installation

• NN10600-605 Passport - MDM Network Security: Operations

• 241-5701-050 Passport 7400, 15000, 20000 Commands
Preside MDM Configuration Management for Passport User Guide   15.1RSUP
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Chapter 1
Introducing Configuration for Passport 
Devices

This section gives a brief overview of Configuration for Passport Devices. In 
this chapter, you can find the following information:

• “Passport Devices configuration tools” (page 21) 

• “Date Convention” (page 25)

Passport Devices configuration tools
Configuration for Passport Devices is a set of tools for managing Passport 
software and service data. It provides a representation of node service data. It 
also provides a simplified logical presentation of operating parameters.

See the following for information on the Passport Devices configuration 
toolset submenu for managing node software and services.

• “Nodal Provisioning” (page 22)

• “Service Provisioning” (page 22)

— “ATM” (page 22)

— “Frame Relay” (page 22)

• “Administration” (page 23)

— “Passport/SNMP Service Data Backup/Restore” (page 23)

• “Software Download and Configuration” (page 23)

— “Network Activation” (page 23)
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• “Inventory Reports” (page 23)

• “Network Reporting System” (page 24)

— See “Service Integrity Audit” (page 24)

— “Configuration Reports” (page 24)

— “Configuration Differences” (page 24)

See “Global Data Manager command line tool” (page 25) for information on 
a command line tool that is used with Configuration for Passsport Devices.

Nodal Provisioning
You can use Nodal Provisioning to provision Passport components and 
selected services. For additional information, see 241-6001-610 Preside 
MDM Nodal Provisioning User Guide.

Service Provisioning
 Service Provisioning contains the following menu items:

• “ATM” (page 22)

• “Frame Relay” (page 22)

ATM
ATM opens the ATM service provisioning application that allows you to 
provision ATM permanent virtual connections, soft permanent virtual 
connections, and selected Frame Relay to ATM connections (FRF.8 standard 
for service interworking (SIWF)). The tool populates the Administration 
Database with circuit data. For additional information, see 241-6001-600 
Preside MDM Service Provisioning for ATM User Guide.

Frame Relay 
Frame Relay opens the Frame Relay service provisioning application that 
allows you to provision Frame Relay permanent virtual circuits between two 
nodes. The Administration Database is populated with circuit data.For 
additional information, see 241-6001-603 Preside MDM Service 
Provisioning for Frame Relay User Guide.
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Administration
Administration contains the following items:

• “Passport/SNMP Service Data Backup/Restore” (page 23) 

• “Software Download and Configuration” (page 23)

• “Network Activation” (page 23)

Passport/SNMP Service Data Backup/Restore
The Passport/SNMP Service Data Backup/Restore tool is a stand-alone tool 
for backing up and restoring the service data on selected nodes. You can 
perform full, incremental, and selective backups and restores. See, 
241-6001-807 Preside MDM Network Backup and Restore for additional 
information

Software Download and Configuration
You can use Software Download and Configuration to configure, download, 
and upgrade software in the Passport network. You can obtain the software 
from a Software Distribution Site (SDS).

See “Software Download and Configuration” (page 35) for more 
information.

Network Activation
You can use Network Activation (NAT) to simplify and automate the 
activation process for multiple nodes in a network. For Passport, you can 
activate and commit a View using NAT.

See “Network Activation” (page 81) for more information.

Inventory Reports
The Inventory Reports item opens the Device Inventory tool. This tool lets 
you report on the hardware and software of selected devices in your network.

 See 241-6001-808 Preside MDM Device Inventory Tools User Guide for 
more information.
Preside MDM Configuration Management for Passport User Guide   15.1RSUP



24   Chapter 1 Introducing Configuration for Passport Devices
Network Reporting System
Network Reporting System contains the following items:

• “Service Integrity Audit” (page 24)

• “Configuration Reports” (page 24)

• “Configuration Differences” (page 24)

Service Integrity Audit
You can use Service Integrity Audit to populate the Network Reporting 
System (NRS) database for DPN and Passport modules, and, optionally, to 
execute the NRS-based Service Integrity checks (NSICs) for DPN and 
Passport modules. In addition it is used to populate the Network 
Configuration Database (NCD) for DPN. With Service Integrity Audit you 
retrieve the Passport View Files directly from the modules.

See 241-6001-022 Preside MDM Network Reporting System User Guide for 
more information about the Service Integrity Audit tool. 

Configuration Reports
The Configuration Reports item opens the Configuration Report dialog that 
lets you produce simple configuration hierarchy reports.

See Configuration Report (xnrsdatah) in 241-6001-022 Preside MDM 
Network Reporting System User Guide for more details.

Configuration Differences
The Configuration Differences item opens the Configuration Differences 
dialog which lets you select two sets of configuration data and produce a 
report on the differences between the two configurations.

See Configuration Differences (xnrsdiff) in 241-6001-022 Preside MDM 
Network Reporting System User Guide for more details.

Connection Manager
You use the Connection Manager to manage your network connections. The 
Connection Manager Authentication dialog is displayed when you access any 
of the tools for Passport Devices configuration.
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See “The Connection Manager and authentication” (page 29) for more 
information.

Global Data Manager command line tool
You can use the Global Data Manager (pgdm), a command line tool, to 
propagate global data components from a Passport node to other selected 
nodes, or to replace the attribute values for the components during 
propagation. In addition, you can use pgdm to replace the attribute values for 
selected nodes in the network.

By allowing data to be copied and propagated, pgdm enables you to provision 
global data more efficiently and to replace attribute values globally. Pgdm 
also reduces the risk of errors due to mistakes in keying in service data.

See “Global Data Manager” (page 135) for more information.

Date Convention
In this document you will often see dates in the format yymmdd. Such dates 
are used as parameters in certain line commands or appear in a dialog or as 
part of a file name.

To account for the year 2000 and beyond, Passport Devices configuration 
interprets 000101 as later than 991231. The base year has been chosen as 
1980. This means 800101 precedes 900101 which precedes 000101 which 
precedes 790101. In other words:

if (yy < 80)
   year = 2000 + yy
else
   year = 1900 + yy

This means:

80 => 1980
90 => 1990
99 => 1999
00 => 2000
10 => 2010
79 => 2079.
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Chapter 2
Starting Configuration for Passport tools

This section explains how you can access the Configuration Management 
tools for Passport nodes. In this chapter, you can find the following 
information:

• “Capability privileges” (page 27)

• “Starting a Configuration tool” (page 27)

• “Closing a Configuration tool” (page 28)

• “Starting the Configuration tools from a UNIX shell” (page 28)

• “The Connection Manager and authentication” (page 29)

• “Authentication warning dialog” (page 32)

• “Performing re-authentication” (page 32)

• “Enabling log files” (page 32)

Capability privileges
To access Passport Devices Configuration tools, you need to have the correct 
capability privileges. 

For more information on capability privileges, refer to the chapter on security 
in NN10600-605 Passport - MDM Network Security: Operations.

Starting a Configuration tool
1 In the application main window, select Configuration -> Passport 

The Passport Configuration toolset submenu is displayed.
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2 Select the tool you want to use.

The tool’s main window is displayed. If the Authentication dialog opens, 
see “The Connection Manager and authentication” (page 29) for more 
details.

Closing a Configuration tool
1 From the File menu in the title bar of the tool window, choose Exit.

The tool’s main window closes.

Starting the Configuration tools from a UNIX shell 
You can access command line applications by using the command line syntax 
from a UNIX shell. 

Accessing UNIX
1 In the application main window, select System -> Utilities -> UNIX access.

The UNIX window is displayed.

2 Enter the command for the tool you want displayed.

For Software Download and Configuration the command is
/opt/MagellanNMS/bin/fsdui

For Passport/SNMP Devices Backup and Restore the command is
/opt/MagellanNMD/bin/nsui

For Service Integrity Audit the command is
/opt/MagellanNMS/bin/sisautui

For Network Activation the command is
/opt/MagellanNMS/bin/natui [-NAF <NAF_filename>]

The tool’s main window appears. If the Authentication dialog opens, see 
“The Connection Manager and authentication” (page 29) for more details.

See 241-6001-802 Preside MDM User Interface Primer for more information 
about Preside Multiservice Data Manager workstation interface.
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The Connection Manager and authentication
The Connection Manager is a server process residing on the Preside 
Multiservice Data Manager workstation. It manages all the network 
connections that are created for your session. The Connection Manager 
displays the Authentication dialog when you access any of the Configuration 
tools. 

Note: For Connection Manager set-up and administrator functions, see 
241-6001-011 Preside MDM Fault Management User Guide.

Authentication dialog
The Authentication dialog displays a list of network destinations and their 
connection states. Valid network destinations for Passport nodes are groups. 
You can select a group from the destination list and enter a valid user ID and 
password. Error messages are displayed in the message area. Upon successful 
network logon, the Authentication dialog automatically closes.

When you log off from Preside Multiservice Data Manager (MDM), all 
network connections associated with your user ID are shut down 
automatically by the Connection Manager. The Connection Manager allows 
only the tool that opened the network connection to close (disconnect) the 
connection. Accordingly, when you log off from your MDM session, the 
Connection Manager shuts down all the active network connections 
belonging to your user ID.

See the figure “Authentication dialog” (page 30).
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Figure 1
Authentication dialog

The Authentication dialog allows you to log on to a network destination, with 
a valid user ID and password. This dialog provides the following information: 

• Server Host displays the server host name. All network communications 
are performed through this host. 

• Destination list lists all the network destinations that are available from 
the current server host. The destination is either a destination mnemonic 
name for the DPN network or a group name for the Passport network. 
Select a destination to set the Destination field and populate the User Id 
list. Double-click on the Destination list to set the destination and 
perform the authentication (you need to supply a user ID and password 
first). The destination state is Authenticated if authentication data is 
available for the destination. 
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• User Id list lists all previously authenticated user IDs associated with the 
selected destination. It allows you to reuse authentication data. Select a 
user ID to set the User Id and Password fields. Double-click on the user 
ID to set the User Id and Password fields and perform the authentication 
action. 

• Destination allows you to manually enter the destination in this field or 
select one from the Destination list. 

• User Id allows you to manually enter the user ID in this field or select 
one from the User Id list. 

• Password allows you to manually enter the password in this field or 
select one, along with a user ID, from the User Id list. 

• Message displays messages related to the current authentication request. 

• Authenticate performs the authentication. The dialog closes upon 
successful completion. Otherwise, an error message is displayed in the 
Message area. You can choose to alter parameters and try again or to 
cancel the request. 

• Cancel closes the dialog without performing an authentication request. 

See “Selecting a Passport group” (page 31) for information on completing the 
Authentication dialog.

Performing authentication
The following procedure shows how you perform authentication by logging 
on to the network through a Passport group.

Selecting a Passport group
1 In the Authentication dialog, enter the Destination manually or select one 

from the Destination list. The destination must be a Passport group.

The selected destination is displayed in the Destination area.

2 Enter your user ID and password.

3 Click Authenticate or press the return key.

If the authentication fails, an error message is displayed. Otherwise, the 
Authentication dialog closes and the main window of the tool is displayed.

If you click Cancel for the Software Download and Configuration tool, see 
“Authentication warning dialog” (page 32).
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Authentication warning dialog
The Authentication warning dialog displays when you cancel the 
authentication process for the Software Download and Configuration tool. It 
indicates that the tool cannot communicate with the network until 
authentication is successful.

See the figure “Authentication warning dialog” (page 32).

Figure 2
Authentication warning dialog

Click Yes to re-display the Authentication dialog. 

If you click No, the Configuration application session is terminated. 

Performing re-authentication
During a session it may become necessary to change the Passport group you 
are working with. You do this by performing the authentication process again. 
When re-authentication takes place, the current connection is closed. 

Display the Authentication dialog again by clicking Authenticate from the 
Security menu of the Configuration tool you are working in. From there, 
follow the process described in “Selecting a Passport group” (page 31). 

Enabling log files
A log file contains processing and error messages that are produced by the 
application. Logging can be enabled by means of the graphical user interface, 
command line, or command file.
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If the -log option is specified in the command file or on the command line, the 
output is directed to the log file and to stdout/stderr. The same messages are 
displayed in both. If the log file already exists, the new data is appended to 
the file. If the log file does not exist, a new one is created.

If two or more applications are running concurrently, the log file may be 
locked by one of the applications. The other applications wait and retry the 
lock later. If the maximum number of lock retries is exceeded, the application 
is aborted. 

For more information on command line syntax and the number of lock retries 
permitted, see the individual tool sections in this guide.
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Chapter 3
Software Download and Configuration

This section describes the Software Download and Configuration tool and the 
procedures for using it. In this chapter, you can find the following 
information:

• “The Software Download and Configuration tool” (page 35)

• “About Passport software” (page 36)

• “Software Download and Configuration main window” (page 38)

• “Software Download and Configuration dialogs” (page 45)

• “Software Download and Configuration procedures” (page 54)

The Software Download and Configuration tool
Software Download and Configuration allows you to configure, download, 
and upgrade software in the Passport network. You can use NN10600-270 
Nortel Networks Multiservice Switch 7400/15000/20000 Software 
Installation, as a reference when performing the procedures in this chapter. 
This document discusses the concepts and components associated with 
configuring a Passport network and provides information on transferring 
software onto the Software Distribution Site (SDS).

The Passport Software Download and Configuration tool resides on an 
Preside Multiservice Data Manager workstation. It uses the Connection 
Manager (CM) services to establish the connection to the Passport network; 
it uses services provided by other processes to modify the service data view 
and to send commands to network nodes.
Preside MDM Configuration Management for Passport User Guide   15.1RSUP



36   Chapter 3 Software Download and Configuration
See also...

• “About Passport software” (page 36)

• “Software Download and Configuration main window” (page 38)

• “Software Download and Configuration dialogs” (page 45)

• “Software Download and Configuration procedures” (page 54)

About Passport software
A Passport module can hold up to 16 processor cards. Each processor card is 
identified by its slot number. To load software for processor cards, define the 
feature (service) and version supported on each processor card in the service 
data view.

The application version list (AVL) is a provisionable attribute of the Passport 
software component. The AVL contains a list of application versions installed 
(or to be installed) on a module. Only one logical processor type (LPT) is 
associated with the control processor (CP) and the name CP is reserved for 
this LPT. A logical processor (LP) represents the entire body of software to 
be run on a processor card. Because an LP is a logical entity, it can be mapped 
to any processor card according to your configuration. An LP can be mapped 
to one processor card as the main (active) card for supporting a service, and 
to a standby card for backup should the main card fail. See NN10600-270 
Nortel Networks Multiservice Switch 7400/15000/20000 Software 
Installation for more information.

The following is a summary of provisionable attributes related to the software 
configuration of an LPT, an LP, and a card. See 241-7501-210, Passport 
Components for more information on provisionable attributes.

LPT
The attributes are as follows:

• Feature List: A list of features (services) loaded (or to be loaded) on the 
processor.

• System Configuration: Configuration parameters on start-up.

• Comment Text: An arbitrary string that can be used to describe the LPT.
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LP
The attributes are as follows:

• Main Card: The main processor card to which this LP is assigned.

• Spare Card: The backup processor card (if a spare processor card is 
available) to which this LP is assigned.

• Logical Processor Type: This is the LPT that specifies which software 
this LP will run.

• Customer Identifier: The Passport Customer Identifier of the LP.

Card
There is only one provisionable attribute:

• CardType: Indicates the type of card expected to match the hardware.

The figure “Relationships among cards, LPs, and LPTs” (page 38) shows the 
relationships among processor cards, LPs, and LPTs.
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Figure 3
Relationships among cards, LPs, and LPTs

Software Download and Configuration main window
See the following sections for information on the parts of the Software 
Download and Configuration main window:

• “Menu bar” (page 39)

• “SDS data area” (page 41)

• “Target EM data area” (page 42)

• “Messages area” (page 45)

See the figure “Software Download and Configuration main window” 
(page 39).

Processor cards
(Cards)

Card 0

Card 1
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Card 3

Card 15

Logical processors 
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Logical processor types 
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LP 5
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Primary mapping (main)

Secondary mapping (spare)

A user-specified feature name<name>
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Figure 4
Software Download and Configuration main window

Menu bar
The menu bar is located at the top of the Software Download and 
Configuration main window. See the following sections for information on 
the menu bar entries:

• “File menu” (page 40)

• “Edit menu” (page 40)
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• “Options menu” (page 40)

• “Security menu” (page 41)

File menu
The Exit command closes all windows. You receive a warning if the 
configuration data is altered but not saved. 

Edit menu
The Edit menu gives you access to the following dialogs: 

• Add LPT Opens the Add LPT dialog. This command is enabled when you 
have established an SDS connection and the view is uploaded. 

• Add LP Opens the Add LP dialog. This command is enabled when a you 
have established an SDS connection and the view is uploaded.

Options menu
The Options menu gives you access to the following dialogs: 

• Run Command File displays the Command File dialog. Use this dialog 
to run an existing command file. This function is enabled if the 
authentication is completed. 

• Enable Download Address Selection lets you choose a different defined 
address. By default, the LAN address of the SDS is used to download 
software. When the download AVs or save view function is invoked, an 
SDS Address Selection dialog is displayed to retrieve the SDS address. 
The defined address can be kept in a configuration file that contains 
many entries with the following format: 

<SDS LAN address> <Passport IP address> <IP/XVC 
address>

The configuration file is named fsdcfg.data and stored under the /opt/
MagellanNMS/data directory. 

• Disable Download Address Selection uses the LAN address of the SDS 
to download the software. 

You can toggle between the Enable and Disable options by clicking the 
current option. 
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• Enable Force Download AVs forces a download of the software even if 
it already exists on the Passport disk.

• Disable Force Download AVs performs a check to determine if the 
software to be downloaded already exists on the Passport disk. If it does 
exist, the download is not performed. 

You can toggle between the Enable and Disable options by clicking the 
current option.

Security menu
Authenticate displays the Authentication dialog. You use this dialog to enter 
the authentication information that gives you access to the target Passport 
node. 

SDS data area
The SDS data area contains the “Available AVs on SDS list” (page 41). The 
AV name is a concatenation of the application name and its version level 
(separated by an underscore character). For example, trunks_AB04v.

To retrieve this list, click the “Show SDS AVs button” (page 41). 

Available AVs on SDS list
This is a list of available application versions (AVs) on the Software 
Distribution Site (SDS). It is a multi-select list, and each list item is the name 
of an AV. The AV name is a concatenation of the application name and its 
version level (separated by an underscore character). 

List item functions:

• Update AVL lets you update the selected AVs. 

• Show Patch List displays all of the available patches on the SDS for the 
selected AVs.

Show SDS AVs button
Click this button to retrieve a list of available AVs on the SDS disk. 

A dialog is displayed, requesting the information necessary to log on to the 
SDS. 
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Target EM data area
This section contains details on the target EM (Enterprise module is a 
Passport module).

See also...

• “Target EM name field” (page 42)

• “Show Modules button” (page 42)

• “AVL (application version list)” (page 42)

• “LPT (logical processor type) list” (page 43)

• “LP (logical processor) list” (page 43)

• “Sparing Connection button” (page 44)

• “Cards” (page 44)

• “Download AVs button” (page 44)

• “Get View button” (page 44)

• “Verify button” (page 45)

• “Save View button” (page 45)

Target EM name field
Enter the node name in this field, or invoke the Show Modules... function to 
get a list of the available names. 

Show Modules button
Click this button to get a list of available nodes that are accessible in the 
current group. This button is enabled if authentication is completed.

See also...

• “Module List dialog” (page 46).

 AVL (application version list) 
The AVL is a single-select list. It holds the versions of each application that 
can run on the node. Each list item contains the name of an application 
version (AV), which is a concatenation of the application name and its version 
level (separated by an underscore character). 
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List item functions: 

• Show Compatible AVs displays a list of all AVs that are compatible with 
the selected AV in the AVL. The AVs in this dialog can be selected and 
added to the AVL. 

• Show Patch List displays a dialog that lists the following patches: all of 
the available patches on the SDS for the selected AV, and all of the 
provisioned patches in the view file that you loaded. From this dialog you 
can display another dialog that lists any prerequisite patches for the 
patches you are going to provision. These dialogs let you provision the 
prerequisite and selected patches in the view file.

• Delete deletes the selected AV from the AVL. 

LPT (logical processor type) list
The LPT list is a single-select list, where each list item holds the name of a 
logical processor type (LPT) that specifies the characteristic of the software 
that needs to be loaded on a processor card. 

Note: Only one LPT is associated with the CP, and the LPT name CP is 
reserved for this LPT. 

List item functions: 

• Add LPT adds a new LPT. 

• Delete deletes the selected LPT. 

• Edit modifies the selected LPT.

• View lets you view the selected LPT but not edit it. 

 LP (logical processor) list
The LP list is a single-select list where each list item holds a logical processor 
number. 

List item functions: 

• Add LP adds a new LP. 

• Delete deletes the selected LP. 
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• Edit enables you to modify the selected LP. 

• View lets you view the selected LP but not edit it.

Sparing Connection button
Click this button to display a dialog that allows you to set one-for-n sparing 
connections. This button is not available for Passport releases prior to 5.0.

See also...

• “Sparing Connections dialog” (page 49)

Cards
You can use this area to display and modify the cards of an uploaded node 
view. The CP slots in this area are set according to the type of node you are 
configuring, for instance, first slot and last slot for the Passport 7400 series 
and slots 0 and 1 for the Passport 15000. 

This area is enabled when the configuration data is uploaded. Use the 
associated data selector to select the CardType. 

Download AVs button
Click this button to download selected AVs from the SDS to the target node. 
This button is enabled when the Available AVs on SDS list and Target EM 
name field are both not empty. You need to select at least one AV from the 
Available AVs on SDS list. Optionally, you can specify an SDS IP address that 
can be used for software downloading by selecting the Enable Download 
Address Selection entry from the Options menu. 

Get View button
Click this button to load a specific provisioning data file that contains the 
software configuration data into the editing view from the target node. The 
software configuration data consists of the software/application version list 
(AVL), the logical processor type (LPT), the logical processor (LP), and the 
cards. 

A dialog is displayed to obtain parameters used for loading the view. 

See also...

• “Get View Parameters dialog” (page 50)
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Verify button
Click this button to perform semantic checks for the configuration data. This 
button is enabled if the configuration data is uploaded. 

Save View button
Click this button to save the modified software configuration data back to the 
target node. 

A dialog is displayed to obtain parameters used for saving the software 
configuration data. 

See also...

• “Save View Parameters dialog” (page 51)

Messages area
Messages generated by Software Download and Configuration in the course 
of its operations are displayed in this area. You can scroll the text field to read 
previous messages. 

Software Download and Configuration dialogs
See the following sections for information on Software Download and 
Configuration dialogs:

• “Module List dialog” (page 46)

• “Patch List dialog from the Available AVs on SDS” (page 46)

• “Patch List dialog from the AVL” (page 46)

• “Prerequisite Patch List dialog” (page 47)

• “Logical Processor Type dialog” (page 47)

• “Logical Processor dialog” (page 48)

• “Sparing Connections dialog” (page 49)

• “Get View Parameters dialog” (page 50)

• “Save View Parameters dialog” (page 51)

• “SDS Address Selection dialog” (page 52)

• “SDS Authentication dialog” (page 52)
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• “Processor Targets dialog” (page 53)

• “Command File dialog” (page 53)

Module List dialog
The Passport Module List dialog is displayed when you click the Show 
Modules button. It is used to display a list of available nodes that are 
accessible from the current group. It consists of:

• Filter data entry field that allows you to condense the list of available 
nodes.

• List of accessible nodes.

• Target EM field that displays the node you select from the list.

The buttons are:

• OK places the name of the Target EM in the Target EM name field on the 
main window.

• Cancel closes the dialog.

Patch List dialog from the Available AVs on SDS
This dialog lists all the available patches on the SDS for all of the AVs you 
selected on the Available AVs on SDS list. This dialog is for display purposes 
only.

Patch List dialog from the AVL
From this dialog you can provision selected patches. The column Patches 
from SDS lists all the available patches on the SDS for the AV you selected 
on the AVL (application version list).

The column Provision Patch List lists by default all the patches that are 
provisioned in the view file you uploaded. The patches listed under Provision 
Patch List are the patches that you can provision. You can provision a patch 
more than once. 

Press the mouse menu button under Patches from SDS to display the option 
Add to Provision Patch List. This option copies the selected patch to the 
Provision Patch List column, where you can provision it.
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Press the mouse menu button under Provision Patch List to display the 
options Show Prerequisite patches and Delete. Show Prerequisite patches 
displays the Prerequisite Patch List dialog, which lists the patches you need 
to provision before you can provision the selected patch in the Provision 
Patch List. Delete deletes the selected patch from the Provision Patch List.

The buttons are:

• Accept Provision List provisions the patches in the Provision Patch List. 
The patches are activated when the view file is activated.

• Cancel closes the dialog without provisioning the patches.

Prerequisite Patch List dialog
This dialog lists all the patches you need to provision before provisioning the 
patches you selected in the Patch List dialog from the AVL. 

The buttons are:

• Provision All provisions all the prerequisite patches. The patches are 
activated when the view file is activated.

• Cancel closes the dialog without provisioning the patches.

Logical Processor Type dialog
The Logical Processor Type dialog is used to create a new logical processor 
type (LPT) or modify an existing one, and consists of:

LPT Name: The LPT name. Only one LPT is associated with 
the CP, and the LPT name CP is reserved for this 
LPT. 

System Configuration: The Passport network requires some configuration 
parameters on start-up. The combinations of 
possible settings are predefined and each possible 
setting has a name associated with it. Select the 
System Configuration combination by using the 
data selector. 
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Logical Processor dialog
The Logical Processor dialog is used to create a new logical processor (LP) 
or modify an existing one, and consists of: 

Comment Text: An arbitrary string that can be used to enter a 
comment on the LPT.

LPT Features list: Consists of a list of features that you need to load 
on the processor.

Available Features list: Consists of a list of available features you can be 
select and add to the LPT Features list.

Referenced LPs: A read-only list that shows which logical 
processors (LP) are currently referencing this LPT.

OK button: You can use this button to add the LPT in the LPT 
list and close the dialog if all of the mandatory 
fields are not empty.

Show Features button: Displays the available features in the Available 
Features list.

Cancel button: You can use this button to discard the changes and 
close the dialog.

Verify button: Performs the LPT semantic checks. Errors, 
warnings, and informational messages are 
displayed in the Messages area.

LP Number: Use the data selector to select the LP number. 

The LP's node 
Customer Identifier, 
which is compatible 
with DPN, DPN-100 
NetMan, and Basic 
CIDs. 

Customer Identifier:
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Sparing Connections dialog
The Sparing Connections dialog allows you to set sparing connections using 
one-for-n sparing. One-for-n sparing enables you to protect multiple main 
function processors (FPs) with a single spare FP. For more information on this 
feature, see NN10600-550 Nortel Networks Multiservice Switch 7400/15000/
20000 Common Configuration Procedures.

The dialog allows you to assign one spare for up to four main cards. There is 
an entry for each of the 16 card slots you may have in a Passport node. You 
can set sparing connections on any slots except those reserved for control 
processors (CPs). You cannot perform one-for-n sparing on CPs.

Main Card: The preferred processor card onto which you need to 
assign this LP.

Spare Card: The spare processor card onto which you need to 
assign this LP.
LP/0 needs to reference only the first card or last card 
for Passport 7400 series, and only cards 0 or 1 for the 
Passport 15000. Both need to have CardType CP. 
Main and Spare card numbers need to be different. 
Main and Spare CardTypes must match. 

Referenced LPT: The LPT name that determines which software this LP 
runs. You can use the data selector to select the LPT 
name.
LP/0 needs to reference LPT/CP.

Cancel button: You can use this action button to discard the changes 
and close the dialog. 

OK button: You can use this action button to add the LP in the LP 
list and close the dialog. 

Verify button: Performs the LP semantic checks. Errors, warnings, 
and informational messages are displayed in the 
Messages area. 
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Pressing the menu button, while the arrow is on the arrow symbol to the right 
of a slot, displays a list of options that allows you to designate the card as a 
spare or one of the four main cards. The option notApplicable means you 
cannot use one-for-n sparing for this card.

The buttons are:

• OK keeps your changes and closes the dialog.

• Verify runs semantic checks. Errors, warnings, and informational 
messages are displayed in the Messages area.

• Cancel discards your changes and closes the dialog. 

Get View Parameters dialog
These parameters are used in loading the software configuration data into the 
editing view, which contains the software/application version list (AVL), the 
logical processor type (LPT), the logical processor (LP), and the cards. 

The mode indicates the search mode that the tool uses to find the name of the 
provisioning data file. You can select one of the following modes: 

User Specified: Enables you to specify if a particular provisioning data file 
is to be loaded. You need to specify the file name in the 
data entry field.

Keyed: Enables you to specify that a key is used to search for the 
provisioning data file to be uploaded. You need to specify 
a key in the data entry field; it can be made up of letters, 
digits, and underscores. The key cannot begin with an 
underscore and cannot exceed six characters. 

Dated: Enables you to specify that a date key is used to search for 
the provisioning data file to be loaded. You need to specify 
a valid date in the format yymmdd in the data entry field. 
See “Date Convention” (page 25) for more information on 
the date format. 
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The buttons are:

• OK loads the specified provisioning data file from the node. 

• Cancel closes the dialog. 

Save View Parameters dialog
Enter the save mode in this area. The parameters are used when saving the 
provisioning data file. 

Save view mode indicates the mode that the tool uses to name the newly 
modified provisioning data file. You may select one of the following: 

Committed: Loads the committed provisioning data file on the 
Passport. No data entry field is associated with this mode. 

Current: Loads the current view on the node. No data entry field is 
associated with this mode. 

Edit: Loads the edit view on the node. No data entry field is 
associated with this mode. 

User Specified: Enables you to specify the name that the provisioning 
data file is saved as. You need to specify the file name 
in the data entry field. 

Keyed: Enables you to specify the key to be used to name the 
new provisioning data file to be saved. You need to 
specify a key in the data entry field; it can be made up 
of letters, digits, and underscores. The key cannot begin 
with an underscore, and cannot exceed six characters. 

Dated: Enables you to specify that a date key is used to search 
for the provisioning data file to be saved. You need to 
specify a valid date in the format yymmdd in the data 
entry field. See “Date Convention” (page 25) for more 
information on the date format.
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The options are:

• Perform MDM-Semantic Checks performs semantic checks before 
sending a request to save the provisioning data file. 

• Perform On-Switch Semantic Checks requests the target node to perform 
the semantic checks before saving the provisioning data file. 

The buttons are:

• OK saves the modified configuration data back to the target node. 

• Cancel closes the dialog. 

SDS Address Selection dialog
The Internet protocol (IP) address of the SDS can be configured with a 
different value than the LAN address of the SDS. The address defined in this 
dialog is used by the target node to get the software from the SDS. If the 
downloading of software is successfully completed, and if this defined 
address is different from the LAN address of the SDS, then it is saved in the 
configuration file. 

SDS Authentication dialog
The SDS Authentication dialog requests the information required to log on to 
the Software Distribution Site (SDS). It also retrieves the application versions 
(AVs) that will be displayed on the Available AVs on SDS list. It consists of:

• Host data entry field

• User ID data entry field

• Password data entry field

• Application version data entry field that allows wild cards
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The buttons are:

• Skip MDM Validation button lets you bypass the Preside Multiservice 
Data Manager (MDM) validation of the Passport software. Enabling this 
button limits the provisioning capabilities of the tool so that all 
provisioning options, except provisioning a change in the AV application 
version, are disabled. 

When you enable Skip MDM Validation, the Verify button, the Cards 
area in the main window and all LPT and LP functions, except View, are 
disabled

• OK logs on and retrieves a list of available AVs. 

• Cancel closes the dialog. 

• Help accesses the on-line help

Processor Targets dialog
The Processor Targets dialog is displayed when you click the Download AVs 
button on the Software Download and Configuration main window. Use this 
dialog to select the type of CPU or CPUs (central processing unit), i960 or 
ppc, for the software you download. The OK button starts the software 
download process. The Cancel button cancels the software download process.

Command File dialog
The Command File dialog is used to specify and run a command file and it 
consists of: 

IP Address: This Software Distribution Site (SDS) 
information is used by the node to logon to the 
SDS.

User ID: This SDS information is used by the node to 
logon to the SDS.

Password: This SDS information is used by the node to 
logon to the SDS.
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Software Download and Configuration procedures
See the following sections for information on the Software Download and 
Configuration procedures:

• “Configuring the Software Distribution Site address” (page 55)

• “Configuring the node” (page 56)

• “Performing authentication” (page 57)

• “Specifying a target node” (page 57)

• “Listing Application Versions on SDS” (page 58)

• “Getting a view” (page 59)

• “Updating an application version list” (page 60)

• “Provisioning a software patch” (page 61)

• “Editing a logical processor type (LPT)” (page 63)

• “Editing a logical processor (LP)” (page 65)

• “Performing one-for-n sparing” (page 67)

Command File Name: Enter the name of the command file in this 
field (Include the path if the file is not in your 
home directory).

Log to file button: Check this item to turn logging off. Logging is 
on by default. 

Log File Name: This field appears if the log option is turned 
on. Enter the name of the file to which log 
messages are written. Include the path if the 
file is to be stored in a directory other than 
your home directory. 

Run Command File button: Click this button to run the specified command 
file.

Cancel button: Click this button to close the dialog. The 
command file is not executed.
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• “Editing a processor card” (page 68)

• “Saving the modified view” (page 69)

• “Downloading software” (page 71)

• “Upgrading software from a GUI” (page 72)

• “Using a command file” (page 73)

• “Using the command line interface” (page 75)

• “Using log files” (page 73)

Configuring the Software Distribution Site address
Note: The software for Passport 7400, Passport 15000, and Passport 
20000 may be available from the same Software Distribution Site (one 
IP address) as long as different user IDs, with different SDS home 
directories are configured for each.

The LAN address of the Software Distribution Site (SDS) is used to retrieve 
the application control files. To download the software, Software Distribution 
requests the node download process to retrieve software from the SDS using 
the address provided by Software Distribution. Under normal configuration, 
the SDS LAN address is used by both Software Distribution and the node for 
the download process.

The SDS can also be configured to communicate with the node using an 
address that is different from its own LAN address, that is, the SDS has 
multiple virtual circuits (VCs). The node is unable to reach the SDS if the 
SDS LAN address, which is provided by Software Distribution by default, is 
used.

In this configuration, you need to provide the address of the SDS that is used 
to communicate with the node (referred hereafter as SDS-Passport address), 
not the SDS LAN address. This can be done by using the “Enable Download 
Address Selection” menu and an optional user-defined configuration file.
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The SDS-node address can be predefined in an editable configuration file 
called /opt/MagellanNMS/data/fsdcfg.data. Each line in the file specifies 
SDS addresses and associated node (Passport) address.The file has the 
following format:

<SDS LAN address> <Passport address> 
<SDS-Passport address>

where:

<SDS LAN address> is the SDS address.

<Passport address> is the Passport node address.

<SDS-Passport address> is the address used by the SDS to 
communicate with the node.

You need to specify the address in IP format (for example, 123.1.1.1).

When the Enable Download Address Selection option is set on and the 
Download AVs or Save View options are selected, a dialog is displayed 
requesting the SDS-Passport address. By default, the SDS LAN address is 
shown as the SDS-Passport address if the SDS-Passport address is not defined 
in the configuration file. The SDS-Passport address display can be changed; 
the configuration file is updated with new address information after the 
operation is successfully performed.

When the Enable Download Address Selection option is not selected, and the 
Download AVs or Save View option is selected, the SDS LAN address is used.

See also...

• “SDS Address Selection dialog” (page 52)

• “SDS Authentication dialog” (page 52)

Configuring the node
The following steps must be performed to configure a Passport node:

1 Specify a Group.

See “Performing authentication” (page 57).
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2 Specify a target node.

See “Specifying a target node” (page 57).

3 Retrieve a list of available AVs on the SDS.

See “Listing Application Versions on SDS” (page 58).

4 Upload a view.

See “Getting a view” (page 59).

5 Add required application versions (AV) into the AVL area.

See “Updating an application version list” (page 60).

6 Provision any required software patches.

See “Provisioning a software patch” (page 61).

7 Configure the LPTs, LPs, and cards.

See “Editing a logical processor type (LPT)” (page 63),
“Editing a logical processor (LP)” (page 65),
and “Editing a processor card” (page 68).

8 Save the modified view.

See “Saving the modified view” (page 69).

Performing authentication
When the Software Download and Configuration application is started, the 
Connection Manager (CM) is invoked. The Passport group containing the 
target node needs to be identified and authenticated before the session can 
continue. 

Specifying a target node
You need to specify a target Passport node before you perform any 
configuration or download functions. There are two methods of specifying a 
target node.

1 Enter the node name in the Target EM area in the main window.

OR

Click Show Modules in the main window.
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The Passport Module List dialog is displayed.

A list of modules associated with the group specified in the authentication 
window is displayed.

2 To limit the list of module names, enter a filter in the Filter data entry field.

3 Click Filter.

A list of modules containing the data specified in the filter is displayed.

4 Select the module.

The selected module name is displayed in the Target EM data entry field.

5 Click OK.

This dialog is closed and the selected module name is displayed in the 
Target EM area.

Listing Application Versions on SDS
To configure or download software, you need to retrieve a list of available 
AVs on the Software Distribution Site (SDS). After the main window is 
displayed and authentication is successfully completed, perform the 
following steps to retrieve a list of AVs available on the SDS.

1 Click Show SDS AVs on the main window.
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The Authentication dialog is displayed, requesting the information 
necessary to log in to the Software Distribution Site (SDS).

2 Enter the Host, User ID, and Password of the SDS. 

3 You can use the Application Version data entry field to specify search 
criteria for the AVs. This customizes the AVs listed in the Available AVs on 
SDS area in the main window.

4 Click OK.

An FTP connection to the SDS is established and the application version 
control files are retrieved. An FTP connection is established even if the 
SDS is on the same workstation. The application names and their version 
numbers are displayed in the Available AVs on SDS area in the main 
window.

Note: You can bypass the Preside Multiservice Data Manager (MDM) 
Validation of the Passport software by enabling the Skip MDM 
Validation button. If you do this, your provisioning capability is limited 
to provisioning a change in the AV application version.

Getting a view
The Get View Parameters dialog is used to specify the search mode that the 
Software Distribution and Configuration application uses to find the name of 
the service data view.

1 Specify the Target EM on the main window using one of the two methods 
described in “Specifying a target node” (page 57).
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2 Click Get View....

The Get View Parameters dialog is displayed.

3 Specify upload view parameters by selecting the appropriate radio button 
and filling in the data entry field where applicable.

4 Click OK.

The tool establishes a provisioning session with the node and tries to 
retrieve the data for the AVLs, LPTs, LPs, and cards specified in the 
service data.

Note:  You can configure AVLs, LPTs, LPs, and cards only when they are 
displayed in the Available AVs on SDS area.

The View File Name is displayed under the Passport Name.

Updating an application version list
After the Available AVs on SDS list is retrieved and a view is uploaded, 
perform the following steps to update an application version list (AVL).

1 Select the appropriate AVs from the Available AVs on SDS list.

2 Press the mouse menu button in the Available AVs on SDS area in the 
main window and choose Update AVL.

The selected AV name is displayed in the AVL area of the main window.

OR

3 Select an AV in the AVL area.
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4 Press menu in the AVL area and choose Show Compatible AVs.

A dialog displays a list of all AVs compatible with the AV selected in the 
AVL.

5 Select one or more AVs from the list.

6 Click Update AVL.

The selected AV names are displayed in the AVL area of the main window.

Provisioning a software patch
1 Specify a target node. See “Specifying a target node” (page 57).

2 Retrieve a list of available AVs on the SDS. See “Listing Application 
Versions on SDS” (page 58).

3 Retrieve the required view file. See “Getting a view” (page 59).

4 Make sure the appropriate AVs are listed in the AVL (application version 
list). See “Updating an application version list” (page 60) if you need to 
add any AVs to the AVL.

5 In the AVL, select the AV with the patch to be provisioned.

6 Press the mouse menu button in the AVL and select Show Patch List. 
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The Patch List dialog from the AVL opens.

7 For any patch listed under Patches from SDS that you want to provision, 
select it, press the mouse menu button, and select Add to Provision Patch 
List.

8 For any patch listed under Provision Patch List that you do not want to 
provision, select it, press the mouse menu button and select Delete.

9 To check if an entry in the Provision Patch List has any prerequisite 
patches, select it, press the mouse menu button, and select Show 
Prerequisite patches. The Prerequisite Patch List dialog opens.
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10 If there are any entries listed in the Prerequisite Patch List dialog, click 
Provision All to provision them in the view file and close the dialog. The 
entries are added to the Provision Patch List in the Patch List dialog from 
the AVL.

11 Click Accept Provision List to provision the patches in the view file and 
close the dialog.

12 Repeat steps 5 to 11 for every AV that requires a patch. The patches are 
activated when the view file is activated.

Editing a logical processor type (LPT)
You can perform the following steps (create, modify, or delete) to a logical 
processor type (LPT). 

Before you edit a logical processor type, ensure that you have done the 
following:

• connected to the Software Distribution site

•  obtained a view from the node that you are planning to upgrade

• selected the features (AV)s that you want to upgrade and updated them. 
See, “Updating an application version list” (page 60)

Creating a new LPT
1 Press menu in the LPT area header in the main window and choose Add 

LPT.

OR

From the Edit menu on the menu bar, choose Add LPT...
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The Logical Processor Type dialog is displayed.

2 Specify the LPT Name, Configuration, and Comment Text.

To view the options available for System Configuration, press the data 
selector and choose one of the listed options.

3 To display the list of available features, click Show Features. 

4 Select the features required, press menu, and choose Add to LPT.

The features are now listed in the LPT Features area.

5 Click Verify.

All errors, warnings, and informational messages are displayed in the 
Messages area in the LPT dialog.

6 Select OK to close the dialog.

The new LPT is displayed in the LPT area of the main window.
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Note:  You can still add an LPT if the semantic checks fail. When you add 
an LPT, an “X” box is displayed beside the LPT in the LPT area to indicate 
that an error has occurred.

All errors, warnings, and informational messages are displayed in the 
Messages area in the main window.

Modifying an existing LPT
1 Select the LPT that you want to modify.

2 Press menu in the LPT area and choose Edit.

The Logical Processor Type dialog is displayed.

Note:  The Reference LP, Main Card, and Spare Card associated with the 
LPT are listed in the dialog in read-only format.

3 Modify the LPT Name, Configuration, Comment Text, or Features of the 
selected LPT.

To view the options available for Configuration, press the associated data 
selector and choose one of the listed options.

4 Click Verify.

All errors, warnings, and informational messages are displayed in the 
Messages area in the LPT dialog.

5 Click OK to save the changes and close the dialog.

Note:  An “X” box is displayed beside the LPT in the LPT area to indicate 
that an error has occurred.

All errors, warnings, and informational messages are displayed in the 
Messages area in the main window.

Deleting an LPT
1 Select the LPT that you want to delete. 

2 Press menu in the LPT area and choose Delete.

The selected LPT is removed from the LPT area.

Editing a logical processor (LP)
You can perform the following steps (create, modify, or delete) to a logical 
processor (LP). Before you edit a logical processor, ensure that you have done 
the following: 

• connected to the Software Distribution site
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•  obtained a view from the node that you are planning to upgrade

• selected the features (AV)s that you want to upgrade and updated them. 
See, “Updating an application version list” (page 60)

Creating a new LP
1 Before you create an LP, ensure that you have defined the processor 

card. See “Editing a processor card” (page 68).

2 Press menu in the LP area header in the main window and choose New 
LP.

OR

From the Edit menu on the menu bar, choose Add LP.

The Logical Processor dialog is displayed.

3 Specify the LP Number, Customer Identifier, Main Card, Spare Card, and 
Referenced LPT.

For a list of available options, press the data selector associated with 
each field and choose one of the listed options.

4 Click Verify.

All errors, warnings, and informational messages are displayed in the 
Messages area on the LP dialog.
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5 Select OK to save the changes and close the dialog.

The new LP is displayed in the LP area of the main window.

Note:  An “X” box is displayed beside the LP in the LP area to indicate that 
an error has occurred.

All errors, warnings, and informational messages are displayed in the 
Messages area in the main window.

Modifying an existing LP
1 Select the LP that you want to modify. 

2 Press menu in the LP area and choose Edit.

The Logical Processor dialog is displayed.

3 Modify the LP Number, Customer Identifier, Main Card, Spare Card, or 
Referenced LPT Name.

To view the available options, press the data selector associated with 
each field and choose one of the listed options.

4 Click Verify.

All errors, warnings, and informational messages are displayed in the 
Messages area in the LP dialog.

5 Click OK to save the changes and close the dialog.

Note:  An “X” box is displayed beside the LP in the LP area to indicate that 
an error has occurred.

All errors, warnings, and informational messages are displayed in the 
Messages area in the main window.

Deleting an LP
1 Select the LP that you want to delete. 

2 Press menu in the LP area and choose Delete.

The LP is removed from the LP area.

Performing one-for-n sparing
You can perform one-for-n sparing on nodes running Passport releases 
beginning with 5.0. For more information, see NN10600-550 Nortel 
Networks Multiservice Switch 7400/15000/20000 Common Configuration 
Procedures. 

1 Click Sparing Connection.
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The Sparing Connections dialog opens.

2 Designate the required card by pressing the menu button when the arrow 
is on the arrow symbol to the right of the card.

A list of options is displayed.

3 Set the card to be a spare or one of four main cards.

4 Click Verify to perform semantic checks.

All errors, warnings, and informational messages are displayed in the 
Messages area.

5 Click OK to save your changes and close the dialog.

Editing a processor card
You can perform the following steps to define a new processor card and to 
specify the type of service card, for example, V35.

Defining a new processor card
1 Set the CardType of the processor card by using the data selector 

associated with a card number.

2 Create a new LP to run the selected LPT software on the processor card.

3 Create a new LPT if a suitable LPT does not already exist.

4 Click Verify.
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All errors, warnings, and informational messages are displayed in the 
Messages area in the main window.

Changing the software load of a processor card
You can use different methods to change the software load on a processor card 
as follows:

• Create a new LPT with the new software, and map the existing processor 
card and LP to this new LPT.

• Locate an LPT within the Passport node that contains the software you 
require, and map the existing processor card and LP to this LPT. See 
“About Passport software” (page 36) for the mapping between LPTs, 
LPs, and cards.

• Change the software associated with an LPT to include the new software, 
and map the existing processor card and LP to this LPT.

Saving the modified view
The Save View dialog allows you to specify the mode the tool uses to name 
the newly modified view. You can use two check boxes in this dialog to 
specify where the semantic checks are performed. 

You can perform semantic checks from the graphical user interface for the 
AVL, LPT, LP, and cards. The semantic checks ensure that no inconsistencies 
exist with the components specified. 

When you select Perform MDM Semantic Checks, only the components 
related to software (AVL, LPT, LP, and cards) are checked. When you select 
Perform On-Switch Semantic Checks, all components are checked to ensure 
the view can be activated. By default, the semantic checks are performed on 
both the Preside Multiservice Data Manager (MDM) workstation and the 
node when the view is saved.

1 Click Save View from the main window.

The Save View Parameters dialog is displayed.

2 Semantic checks are performed on the MDM and on-switch by default. If 
you do not require semantic checks, deselect the check boxes.

The Full check and Stop on error boxes are enabled if the node file 
supports the Check changed and stopOnError options.       
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To perform semantic checking on the changed components only, deselect 
the Full Check button.    

To get all semantic errors, deselect the Stop On Error button. 

3 Specify the save view parameters by selecting the Option mode you wish 
to save the view as. The save options are:

• Ascii to save the view in an ASCII format.

• Portable to save the complete view in a portable format.         

Note:  Saving the view in ASCII format may take a long time, and it also 
takes more time to load the ASCII file.

4 Fill in the View File Name field, if applicable.

If the Enable Address Selection option is selected from the Options menu, 
the SDS IP Address is displayed in this dialog.

5 Click OK.

When the save is complete, a message is displayed in the Messages 
area.

After you select OK, the tool performs the following tasks before the view is 
actually saved:

• Performs semantic checks for software configuration components 
(AVLs, LPTs, LPs, and cards) if the Perform MDM Semantic Checks 
option has been selected.

• Opens a new session to the target node.

• Retrieves a list of AVs available on the Passport disk.

• Triggers the target node download process to transfer the AVs specified 
in the AVL that do not exist on the node disk.

• Requests the target node to add data for new components or replace data 
for modified components.

• Requests the target node to perform semantic checks for the whole 
provisioning view if the Perform On-Switch Semantic Checks option is 
selected.

• Requests the target node to save the view.
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Downloading software
Passport software is partitioned into applications. A particular version of an 
application is called an application version (AV). All Passport software is 
stored on the Software Distribution Site (SDS) in a hierarchical directory 
structure that has a directory for each AV. No automatic recovery mechanism 
is provided if the download fails; it needs to be restarted.

By default, the SDS LAN address is used to download software. To download 
to a different address, select the Enable Download Address Selection from the 
Options menu. 

You can use the following procedure if you require the software on the node 
but don’t want to configure it, or if a view has been previously saved but the 
software is not yet downloaded to the node. 

1 Enter the Target EM name in the main window.

2 Click Show SDS AVs.

The Authentication dialog is displayed requesting the information 
necessary to log in to the Software Distribution Site (SDS).

3 Enter the Host, User ID, and Password of the SDS.

4 Click OK.

An FTP connection to the SDS is established and the application version 
files are identified. The application names and their version numbers are 
displayed in the Available AVs on SDS area.

5 Select the appropriate AVs from the Available AVs on SDS area.

6 Click Download AVs.
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The Processor Targets dialog opens.

7 Select the type or types of CPU for the software you will download.

Note: To cancel the download, click Cancel.

8 Click OK.

A list of available AVs on the Passport disk is retrieved. The tool then 
triggers the target node download process to transfer the AVs that are 
specified but do not already exist on the Passport disk.

All errors, warnings, and informational messages are displayed in the 
Messages area in the main window and indicate when the download 
process is complete.

Upgrading software from a GUI
You can use the graphical user interface (GUI) to replace a version of the 
application and download the new software. If the new version of an 
application does not introduce any new features, you can upgrade the 
software version directly using the command line. If you need to upgrade 
several modules, use the command file input. See “Using a command file” 
(page 73) for the correct file syntax.

You can also use the command line to upgrade the software version and 
download the required software directly. See “Using the command line 
interface” (page 75) for the correct command syntax.

1 Retrieve a list of available AVs on the SDS.

See “Listing Application Versions on SDS” (page 58).
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2 Get the current or committed view.

See “Getting a view” (page 59).

3 Add the required AVs into the AVL area.

See “Updating an application version list” (page 60).

4 If the new software introduces new features, configure the LPTs, LP, and 
cards as required.

See “Creating a new LPT” (page 63), “Creating a new LP” (page 66), and 
“Defining a new processor card” (page 68).

5 Save the modified view.

See “Saving the modified view” (page 69).

Using log files
A log file contains processing and error messages that are produced by the 
command line process. Logging can be enabled by means of the graphical 
user interface, command line, or command file.

If the -log option is specified in the command file or on the command line, the 
output is directed to the log file and to stdout/stderr. The same messages are 
displayed in both. If the log file already exists, the new data is appended to 
the file. If the file does not exist, a new one is created.

If two or more applications are running concurrently, the log file may be 
locked by one of the applications. The other applications wait and retry the 
lock after five seconds. If the maximum number of lock retries exceeds 180, 
the application is aborted.

Using a command file
You can use a command file to specify the required parameters for a 
command. This file may be located on any mounted file system on the 
workstation, which allows the application and the file to reside on different 
machines. The command file uses keywords that match those supported on 
the command line interface (for example, target, av, loadview, and saveview); 
but the authentication information, command file, and log file options cannot 
be specified in the command file. If parameters other than those mentioned 
are specified, they are ignored. Separators can be spaces or tabs; if the first 
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column of a new line is a #, the line is treated as a comment. The command 
file can also be invoked from the graphical user interface. See “Running a 
command file from the GUI” (page 74) for more information.

Example
The following is an example of a command file:

#Start of command file
-target moonbase1 NODER16 NODER17
-av trunk_AA000 base_AA000

The following is an example of a command line that uses the parameters 
specified in a command file. Note that the authentication information is 
provided on the command line and is not included in the command file.

fsdl -auth group1 user pass
-sds 47.236.0.24 ftpuser ftppasswd -f <cmdfile_name>

See also...

• “Command File dialog” (page 53)

Running a command file from the GUI
1 Create a command file using a UNIX editor such as vi. 

See the previous example for an example of a command file.

2 From the Options menu choose Run Command File.

The Command File dialog is displayed.

3 Enter the SDS IP Address, User ID, and Password of the SDS.
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4 Enter the Command File Name.

5 Deselect Log to File if logging is not required.

6 Click Run Command File.

A command line process is invoked to execute the command file. All 
errors, warnings, and informational messages produced by this command 
are displayed in the Messages area of the main window.

Using the command line interface
The command line interface is useful for software upgrading if the new 
application version does not introduce new features. It also enables you to 
read the required parameters from a command file. If several modules are to 
be upgraded, use and execute the command file input in a batch mode.

The command line interface allows you to perform the following actions in 
batch mode:

• download AVs

• replace the AV name specified in the AVL

• access one or more modules to perform the above operations.

To display online help for this command, use the -h option on the command 
line.

Enter the following command syntax as one continuous command.

Command line with a command file
/opt/MagellanNMS/bin/fsdl -auth <passport_group_name>

<capability_id> <passwd>

-sds <sds_ipaddress>|<sds_name> <sds_userid> 

<sds_passwd> -f <command_file_name>

[-loadview <loadmode> [<view_file_name>|<key>| <date>]]

[-saveview <savemode> <view_file_name>|<key>]

[-patchlist <patch1>...]

[-opts [stopOnErr] [checkchanged] [portable | ascii]

[-log [<log_file_name>]]

[-dlforce]
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Command line without a command file
/opt/MagellanNMS/bin/fsdl -auth <passport_group_name>

<capability_id> <passwd>

-sds <sds_ipaddress>|<sds_name> <sds_userid>

<sds_passwd>

-target <passport_name> ... -av <appl_version> ...

[-loadview <loadmode> [<view_file_name>|<key>| <date>]]

[-saveview <savemode> <view_file_name>|<key>]

[-patchlist <patch1>...]

[-prtarget <i960> <ppc>]

[-opts [stopOnErr] [checkchanged] [portable | ascii]

[-log [<log_file_name>]]

[-dlforce]

Note: The following minimum character are required for their respective 
keywords:

COMMITTED COM
CURRENT CUR
USER_SPECIFIED U
KEYED K
DATED D
EDIT E

where:

-auth <passport_group_name> <capability_id> <passwd> are 
the parameters used to log on to a group to which the target node belongs. The 
parameter are:

<passport_group_name> Mnemonic of the group to log on to.
<capability_id> Capability ID to log on with.
<passwd> Password for the capability ID.

-av <appl_version>... is the application version(s) to be downloaded 
from the SDS to the target Passport disk. Valid name has the format 
<application>_<version>.
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-dlforce downloads the specified AVs without checking the existence of 
the AVs.

-f <command_file_name> is the command file used to identify the target 
name(s), application version, and view name to load or save. The following 
command line parameters are ignored if the -f option is specified: -target, -av, 
-loadview, -saveview, and -patchlist.

-h displays help on command syntax and use. This option is the first or only 
parameter you can specify on the command line.

-loadview <loadmode> [<view_file_name>|<key>|<date>]

<loadmode> indicates the mode to be used for uploading a view. Valid 
values are: USER_SPECIFIED(U)/KEYED(K)/DATED(D)/
CURRENT(CUR)/
COMMITTED(COM)/EDIT(E) where:

USER_SPECIFIED (U) treats the <view_file_name> as a completed view 
name.
KEYED (K) means that the <key> can be composed of letters, digits, and 
underscores. The key cannot begin with an underscore and cannot exceed six 
characters in length.
DATED (D) is a valid <date> in the format yymmdd. See “Date Convention” 
(page 25) for more information on the date format.
CURRENT(CUR), COMMITTED (COM)or EDIT(E) have no parameters.

-log [<log_file_name>] when specified in the command file or on the 
command line, directs the output to the log file and to stdout/stderr. The same 
messages are displayed in both. If the log file already exists, the new data is 
appended to the file; if the file does not exist, a new one is created. If no file 
name is specified, then fsdl.log is used by default.

If two or more applications are running concurrently, the log file can be 
locked by one of the applications. The other applications wait and retry the 
lock after five seconds. If the maximum number of lock retries exceeds 180, 
the application is aborted.

-opts [stopOnErr] [checkchanged] [portable | ascii] are 
options are associated with the saveview option:      
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stopOnEr aborts the check immediately upon finding the first error.
checkchanged performs the check only on modified components. 
portable saves the modified view in a portable format.
ascii saves the modified view in an ASCII format.

-patchlist <patch1>... lets you specify the patch or patches to 
provision in the view file. The patches are activated when the view file is 
activated. Only use the patchlist parameter with the loadview and saveview 
parameters.

[-prtarget <i960> <ppc>] lets you download software for the two 
different CPUs (central processing units) that can be on the node. You can 
select one or both CPU types.

-saveview <savemode> <view_file_name>|<key> specifies the new 
view name to be downloaded. There are three modes that can be specified: 
USER_SPECIFIED (U), KEYED (K) or DATED (D). The CURRENT, EDIT 
and COMMITTED options are not valid for the savemode.

-sds <sds_ipaddress>|<sds_name> <sds_userid> <sds_passwd> 
are the parameters used to log on to the Software Distribution Site (SDS). 

The parameters are:

<sds_ipaddress> SDS IP address.
<sds_name> Site name.
<sds_userid> User ID to log on with.
<sds_password> Password for the user ID.

-target <passport_name>... is the Target EM name. You can specify 
more than one at a time.
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Example
The following example is used to download trunk_AA0040 and 
base_AA0040 from SDS (address = 47.209.133.219, userid = ftpuser, 
password = ftppasswd) to the TOR1 node. It also updates the AVL specified 
in the committed view and saves the modified view under myview view. 
Processing or error messages are logged to a file called mylog.

/opt/MagellanNMS/bin/fsdl -auth group1 group1ID 
group1passwd -sds 47.236.0.21 ftpuser ftppasswd 
-target TOR1 -av trunk_AA0040 base_AA0040 
-loadview COM -saveview U myview -log mylog
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Chapter 4
Network Activation

This section describes the Network Activation tool and contains procedures 
for using it. Additional background information is included to help you 
understand how the tool is used. 

You can find the following information on procedures:

• “Starting the Network Activation tool” (page 83)

• “Executing a Network Activation File from the GUI” (page 84)

• “Loading a Network Activation File” (page 87)

• “Modifying Passport Preferences” (page 88)

• “Adding new Network Activation records” (page 89)

• “Modifying a single Network Activation record” (page 90)

• “Modifying several records using the Passport Preference dialog” 
(page 91)

• “Creating or modifying the script lists” (page 92)

• “Clearing all records from the record list” (page 95)

• “Deleting individual records from the record list” (page 96)

• “Saving to a Network Activation File” (page 97)

• “Executing a Network Activation File using the command line” 
(page 98)

• “Using a Cron job” (page 100)
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The information below describes the Network Activation tool:

• “The Network Activation tool” (page 102)

• “Network Activation dialogs” (page 117)

• “Network Activation main window” (page 108)
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Starting the Network Activation tool
Start the Network Activation Tool to load a Network Activation File (NAF) 
or create new Network Activation records, and then execute the NAF. 

Procedure steps
1 In the application main window, select Configuration -> Passport -> 

Administration -> Network Activation tool.

The Network Activation window opens.
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Executing a Network Activation File from the GUI
Executing a Network Activation File (NAF) from the GUI involves the 
following steps:

• loading a NAF, if you wish to execute records from an existing NAF

• making any required modifications to the NA records

• rearranging records so that they appear in the record list in the desired 
execution order

• selecting the records to execute in the record list

• authenticating with the Passport group that is the target for the View

• clicking on Execute to open the Execute dialog

• setting up parameters for the execution in the Execute dialog

• clicking OK in the execution dialog to execute the records

Blue, yellow, or red records are not executed. If both critical and non-critical 
records are selected, the critical records are always executed sequentially 
before non-critical records. If the activation of a critical View fails, the tool 
will not process the next record.

If records apply to nodes in more than one group, you need to authenticate 
with each group to execute all records. To minimize authentication, use the 
up and down arrows to group records according to the group before you 
execute them.

To execute a NAF using the graphical user interface of the NAT, do the 
following:

1 If you wish to execute an existing NAF, load the NAF into the records list 
as described in “Loading a Network Activation File” (page 87).

Note:  You do not need to load a NAF to execute NA records. You can 
create new records in the record list and execute them, and if desired, 
save them to a NAF later.

2 If desired:

• Add any new records as described in “Adding new Network 
Activation records” (page 89).
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• Modify existing records as described in “Modifying several records 
using the Passport Preference dialog” (page 91).

• Delete undesired records as described in “Clearing all records from 
the record list” (page 95).

3 Re-arrange the execution records into the desired execution order.

To move a record, click on the record to select it, then click the up arrow 
or the down arrow to move the record up or down in the list.

If records apply to nodes that belong to more than one group, we 
recommend you order the records according to the group.

Note 1:  You can select and move more than one record at a time.

Note 2:  All critical records are executed first, one at a time, followed by 
the non-critical records.

4 Create or modify pre- or post-activation scripts as described in “Creating 
or modifying the script lists” (page 92).

5 In the NAF window, select the records to be executed by clicking on them.

Only select records that belong to nodes in the same group.

The records become highlighted to indicate that they are selected.

6 Select Passport Group Authenticate from the Security menu.

The Passport Group Authentication Dialog opens. See “Authentication 
dialog” (page 29).

7 Enter or select the group name, and enter a valid user ID and password 
for the group.

8 Click OK to authenticate.

Authentication takes place. If authentication is successful, the dialog 
closes.

9 In the NAF window, click Execute.

The Execution dialog opens.

10 In the Execution dialog, specify:

• the working directory, if desired

• the number of processes to a number other than 1, if required

• the name of a log file to be used for execution information

For more information, see “Execution dialog” (page 129).
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11 Click Execute to begin executing the selected records.

Execution begins and colors of fields and records change as execution 
progresses. Information about the execution is written into the log file you 
specified in the Execution dialog.

While execution is underway, the Execute button is replaced by a Stop 
button that can be used to halt execution. Halting execution turns the 
record in which execution is halted to yellow and launches the Processing 
dialog.

As each process is performed, the corresponding field in the record turns 
from blue to green.

If the action completes successfully, the field turns from green to blue and 
the next field turns green. When all actions on a record are completed 
successfully, the entire record turns blue. If an action fails, the entire 
record turns red or yellow according to the severity of the error.

12 If there are records to execute for nodes in another group, go back to step 
5 to select these records, re-authenticate, and execute them.

13 If you wish to execute the records again, select the records to be 
executed, choose Reset from the record list pop-up menu, and start back 
at step 9 to re-execute the records.
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Loading a Network Activation File
Load an existing Network Activation File (NAF) into the Network Activation 
(NA) record list to prepare the NAF for execution.

Procedure steps
1 Choose Load from the File menu in the Network Activation main 

window.

The Load NAF dialog opens. See also: “Load NAF dialog” (page 118).

If there are any records displayed in the record list, a confirmation dialog 
opens and prompts you for permission to clear entries in the record list 
before loading the NAF.

2 Specify the NAF to load in one of the two following ways:

• Enter the full path of the file in the Network Activation File field.

• In the Filter field, enter the full path of the directory to be used as the 
starting point for finding the NAF to load. In the Directories panel, 
click on the name of the appropriate subdirectory. In the Files panel, 
click on the name of the NAF to load. The name of the file you have 
selected appears in the Network Activation File field.

3 Click Load.

The Load NAF dialog closes and the records from the NAF are loaded 
into the record list.
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Modifying Passport Preferences
Use this procedure to change or set Passport Preferences, which are the 
default values that are used for a new Passport node record.

Procedure steps
1 Choose Passport Preferences from the Options menu in the Network 

Activation main window.

The Passport Preference dialog opens. See “Passport Preference 
dialog” (page 125).

2 Change the appropriate preferences for the target View and the actions to 
be performed. One of the four actions must be selected for the record to 
be valid. 

• If Run pre-activation scripts is selected, you can add one or more 
pre-activation scripts to this record. See “Creating or modifying the 
script lists” (page 92).

• If Run post-activation scripts is selected, you can add one or more 
post-activation scripts to this record. “Creating or modifying the script 
lists” (page 92).

3 Click OK to close the Passport Preferences dialog.

4 If you want to save these preferences for future use, choose Save 
Preferences from the Options menu.
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Adding new Network Activation records
Add any new Network Activation (NA) records to the record list so they can 
be processed (activated and committed) for the desired modules in a network.

Procedure steps
1 If the record list is empty the Network Activation main window, go to 

step 4.

2 Click on a record.

The entire record becomes highlighted to indicate that it is selected. Any 
new record is added immediately below the record that is selected 
(highlighted). If you want to re-order the records, see “Up and down arrow 
buttons” (page 114).

3 Select Add Passport Record... from the Edit menu or from the record list 
pop-up menu.

The Passport Edit dialog opens. See also “Passport Edit dialog” 
(page 121).

4 Enter the module name and target View, and specify the actions to be 
performed.

• If Run pre-activation scripts is selected, you can add one or more 
pre-activation scripts to this record. See “Creating or modifying the 
script lists” (page 92)

• If Run post-activation scripts is selected, you can add one or more 
post-activation scripts to this record. See “Creating or modifying the 
script lists” (page 92).

5 Click OK to add the new record to the record list.

The new record appears after the currently selected record in the NAT 
window.

6 Repeat this procedure, once for each new record to be added to the 
record list.

You are now ready to save the records to a NAF or to execute the NA records 
in the record list.
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Modifying a single Network Activation record
You can modify a single Network Activation (NA) record using the Edit 
Passport dialog if you want to specify different data or actions for the record.

Procedure steps
1 Double-click on the record to be modified in the Network Activation main 

window; or, select the record and choose Edit from record list pop-up 
menu.

The Passport Edit dialog opens if the record is a Passport node NA 
record.

2 Modify the data in the record.

For more information, see “Passport Edit dialog” (page 121).

3 Modify the target view and specify the actions. One of the four actions 
must be selected for the record to be valid.

• If Run pre-activation scripts is selected, you can add one or more 
pre-activation scripts to this record. See “Creating or modifying the 
script lists” (page 92)

• If Run post-activation scripts is selected, you can add one or more 
post-activation scripts to this record. “Creating or modifying the script 
lists” (page 92).

4 Click OK to apply the changes.

You are now ready to save the changes to a NAF or to execute the NA records 
in the record list.
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Modifying several records using the Passport Preference 
dialog

You can modify several records at the same time using the Passport 
Preference dialog. If you choose to modify several records by means of the 
Passport Preference dialog, you can change all the information, except the 
module name. If you wish to change the module name, you need to edit each 
record individually.

Procedure steps
1 Modify the Passport Preferences (see "Modifying Passport Preferences" 

on page 88).

2 In the NA record list, click on each of the records to which the preferences 
are to be applied. 

Each record becomes highlighted to indicate that it is selected.

3 From the record list pop-up menu, choose Use Preferences.

All the selected records now have the same data values as defined in the 
Passport Preference dialog. 

You are now ready to save the changes to a NAF or to execute the NA records 
in the record list.
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Creating or modifying the script lists
You can create or modify the script lists for a Passport node record or for the 
Passport Preferences using the NAT Edit Script dialog. See the following 
procedures:

• “Adding scripts to the script list” (page 92)

• “Deleting scripts from the script list” (page 93)

• “Replacing scripts in the script list” (page 93)

• “Changing the order of scripts in the script list” (page 94)

Adding scripts to the script list
Add pre- or post-activation scripts to a Passport node record or the Passport 
Preferences to run more activation scripts.

Procedure steps
1 From the Passport Preferences or Passport Edit dialog, select the Edit 

button beside the action Run pre-activation scripts or Run post-
activation scripts to add or modify the script list.

The NAT Edit Script dialog opens. See “NAT Edit Script dialog” 
(page 126).

2 Select the Browse button and use the file dialog to select a script or enter 
the script in the Name data entry field.

3 Enter any command line options required for the script in the Options 
data entry field.

4 Select Add to add the script and options to the list of scripts in the top text 
area.

The new script appears at the end of the list.

5 Repeat the steps once for each new script to be added to the script list.

Note:  If you want to replace the script lists contained in every record in 
the NA Record list with the current script list defined in the top text area, 
select Apply to current Passport records. This is available only from 
the Passport Preferences dialog.

6 Click OK to add the script list and close the NAT Edit Script dialog.
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Deleting scripts from the script list
You can delete scripts from the pre-activation script list or post-activation 
script list if the scripts are no longer required.

Procedure steps
1 From the Passport Preferences or Passport Edit dialog, select the Edit 

button beside the action Run pre-activation scripts or Run post-
activation scripts to modify the script list.

The NAT Edit Script dialog opens.

2 Select the script to be deleted in the script list.

The entry is highlighted when selected.

3 Select the Delete button.

Note:  If you want to replace the script lists contained in every record in 
the NA Record list with the current script list defined in the top text area, 
select Apply to current Passport records. This is available only from 
the Passport Preferences dialog.

4 Click OK to delete the script list and close the NAT Edit Script dialog.

Replacing scripts in the script list
You can replace scripts in the pre-activation script list or post-activation script 
list with new scripts.

Procedure steps
1 From the Passport Preferences or Passport Edit dialog, select the Edit 

button beside the action Run pre-activation scripts or Run post-
activation scripts to modify the script list.

The NAT Edit Script dialog opens.

2 Select the script to be replaced in the script list.

The entry is highlighted when selected.

3 Modify the Name data field or Options data field as required.

4 Select the Replace button.

Note:  If you want to replace the script lists contained in every record in 
the NA Record list with the current script list defined in the top text area, 
select Apply to current Passport records. This is available only from 
the Passport Preferences dialog.

5 Click OK to replace the script list and close the NAT Edit Script dialog.
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Changing the order of scripts in the script list
You can change the order of scripts in the pre- or post-activation script list if 
you wish to run them in a different order.

Procedure steps
1 From the Passport Preferences or Passport Edit dialog, select the Edit 

button beside the action Run pre-activation scripts or Run post-
activation scripts to modify the script list.

The NAT Edit Script dialog opens.

2 Select the script to be moved in the script list.

The entry is highlighted when selected.

3 Select the Up arrow or Down arrow to move the script up or down in the 
list.

Note:  If you want to replace the script lists contained in every record in 
the NA Record list with the current script list defined in the top text area, 
select Apply to current Passport records. This is available only from 
the Passport Preferences dialog.

4 Click OK to change the order of the script list and close the NAT Edit 
Script dialog.
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Clearing all records from the record list
Clear all records from the record list in the Network Activation main window 
if you are finished with them.

Procedure steps
1 From the Edit menu, select Clear.

A dialog opens prompting you to confirm that you wish to remove all of the 
records from the record list.

2 Click OK.

The confirmation dialog closes and all records are cleared from the record 
list.
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Deleting individual records from the record list
Delete individual records from the record list in the Network Activation main 
window if there are no longer needed.

Procedure steps
1 In the record list, click on each record that you wish to delete.

Each record becomes highlighted to indicate that it is selected.

2 From the record list pop-up menu, select Delete.

A dialog opens prompting you to confirm that you wish to remove the 
selected records from the record list.

3 Click OK.

The confirmation dialog closes and the selected records are deleted from 
the record list.

You are now ready to save the changes to a NAF or to execute the NA records 
in the record list.
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Saving to a Network Activation File
Use the following procedures to save records in the record list to a Network 
Activation File (NAF). Two commands are available for saving new or 
modified records from the record list to a NAF: Save and Save As... The 
command to use depends on whether you loaded a NAF and whether you 
want to save the record list to an existing NAF or to a new NAF.

Saving records to a NAF that is loaded into the record list
Procedure steps

1 Select Save from the File Menu.

Note:  The Save command is disabled if you haven’t loaded a NAF or if 
no changes have been made to the record list.

The changes are saved to the NAF you loaded.

Saving records to a NAF when you haven’ t loaded one, or to 
a NAF other than the one you loaded

Procedure steps
1 Select Save As from the File menu.

The Save NAF dialog opens. See also: “Save NAF dialog” (page 120).

2 Specify the NAF file name in one of the two following ways:

• Enter the full path of the file in the Network Activation File field.

• In the Filter field, enter the full path of the directory to be used as the 
starting point for saving the NAF. In the Directories panel, click on 
the name of the appropriate subdirectory. In the Files panel, click on 
the name of the NAF to save the file as. The name of the file you have 
selected appears in the Network Activation File field.

3 Click OK.

The dialog closes and the contents of the record list are saved to the 
specified NAF.
Preside MDM Configuration Management for Passport User Guide   15.1RSUP



98   Chapter 4 Network Activation
Executing a Network Activation File using the command 
line 

To execute a Network Activation File (NAF) from the command line, do the 
following:

1 Create the NAF. You can do this with the GUI of the NAT or with an editor 
such as vi. To reduce the possibility of error, we recommend that you use 
the GUI instead of an editor for performing this task. 

For information about the structure of a NAF, see “Network Activation File” 
(page 103).

2 Execute the NAF from a Unix window, by running the natcmd command 
to process the NAF.

See “NAT command line interface” (page 98) for the syntax of the natcmd 
utility.

Note 1:  The command line tool exits when a script returns an error (that 
is, returns 1). The command line tool continues when a script return 
success (that is, returns 0), or a warning (that is, returns > 1).

Note 2:  Scripts cannot invoke a GUI when using the command line.

NAT command line interface 
The NAT provides the user a command line to process the NAF. It can be 
invoked from a UNIX window. The syntax of the command is as follows:

/opt/MagellanNMS/bin/natcmd -f <NAF_filename> \
[-auth <passport_group_name> <userid> <password>] \
[-logfile [<log_filename>]] \
[-np <number_of_processes>] \
[-wd <working_dir>] \
[-quiet]
[-h]

where:

-f is the keyword to specify a Network Activation File (NAF). This 
keyword needs to be followed by the <NAF_filename> parameter.

<NAF_filename> is the full path name of the NAF file that contains the 
records to be executed.
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-auth is the keyword to specify group authentication. This keyword 
needs to be specified if the NAF contains Passport NA records. When 
specified, this keyword needs to be followed by the <group_name>, 
<userid>, and <password> parameters.

<group_name> <userid> <password> is the name of the group, the 
user ID, and the password to log on to nodes in the group.

-logfile is the keyword to specify that log information is to be written to 
a log file. If this keyword is specified without the <log_filename> option, log 
information is written to the file 
$HOME/nat<pid>.<yy><mm><dd>_<hh><mm><ss>.log 
For example: /u/thawkes/nat106.970311_110201.log. 
See “Date Convention” (page 25) for more information on the date format.

<log_filename> specifies the full pathname of the log file.

-np is the keyword to indicate the number of processes to run. When 
specified, this keyword needs to be accompanied by the 
<number_of_processes> parameter.

<number_of_processes> specifies the number of records that can be 
executed simultaneously. The default is 1. The number to specify depends on 
the amount of memory available on the workstation. The higher the number, 
the more memory is used.

-wd is the keyword to specify the working directory for storing the default 
log file and other intermediate working files. When specified, this keyword 
needs to be accompanied by the <working_dir> parameter.

working_dir specifies the full path name of the working directory for 
storing the default log file and other intermediate working files.

-quiet specifies that records in the NAF are to be executed without 
producing messages or storing execution log information in a log file.

[-h] provides help information for the natcmd.
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Using a Cron job
Because the NAT command line starts up all the session servers (cmcfun and 
CM), you can invoke the NAT command line by using the Unix cron facility.

To set up a cron:

• You need to set a value for the EDITOR environment variable. If none is 
set, we suggest setting it to vi by entering the command setenv EDITOR 
vi.

• If file /etc/cron.d/cron.allow exists, the root user account needs to be 
listed in it.

• The root user account cannot be listed in file /etc/cron.d/cron.deny.

To set up a cron, do the following:

1 Open the crontab file for editing, with the default editor set with 
environment variable EDITOR:

crontab -e

The current crontab file opens for editing.

2 Add an entry in the following form to the file:

<minute> <hour> <day> <month> \ 
/opt/MagellanNMS/bin/natcmd <parameters>

where:

<minute> is a value from 0 to 59.

<hour> is a value from 0 to 23.

<day> is a value from 1 to 31.

<month> is a value from 1 to 12.

<parameters> are parameters of the natcmd as 
described in “NAT command line interface” (page 98).

3 Save the crontab file and exit from it. If your editor is vi, press Esc and 
enter the following command to do this:

:wq!

The file is now saved and is ready to be executed automatically.
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Example
The following entry in the crontab file executes a NAF called mynaf in the 
root (/) directory, at 0200 hours (2 AM), March 11, 1997. Because the NAF 
only contains Passport NA records applicable to a group called west, the 
command includes the group name, user ID, and password needed to log on 
to nodes in the group. The command also outputs the logs in file /tmp/
mylogfile.

00 2 11 3 /opt/MagellanNMS/bin/natcmd -f /mynaf -auth 
west

myid xys2 -logfile /tmp/mylogfile 
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The Network Activation tool
The Network Activation Tool (NAT) simplifies and automates the activation 
process for multiple modules in a network. You can use the NAT to activate 
a View and commit a View. You can perform the activation and commit 
operations interactively or in batch mode. You can also use the NAT to 
automatically run pre- or post-activation scripts. See “Pre- and Post-
activation scripts” (page 105).

There are two interfaces for the NAT:

• a graphical user interface

See “Network Activation main window” (page 108).

• a command line interface

See “NAT command line interface” (page 98).

The module type, module name or View name, and actions for network 
activation are stored in a Network Activation File (NAF). The graphical user 
interface lets you create or modify the NAF. To reduce the possibility of error, 
we strongly recommend that you use the graphical user interface for creating 
or modifying a NAF instead of using an editor like vi.

For a description of the fields in a NAF, see “Network Activation File” 
(page 103).
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Network Activation File
The Network Activation file (NAF) is used as the input file for both the 
command line and the GUI. We recommend that you use the GUI to create or 
edit the NAF, in order to ensure its syntactic and logical correctness (although 
it can be edited using any text editor).

Each NA record in the NAF is defined in a single line. Each record specifies 
the module type, module name, the target View, a set of actions, and 
associated parameters. The syntax of a record in a NAF is as follows:

-[em] <module_name> 
-sdfile <mode> <name> 
[-critical]
[-activate] 
[-commit] 
[-noPause|-pause]
[-timeout <minutes>]
[-verify_date] 
[-pre] [-pre_scr <script_list>]
[-post] [-post_scr <script_list>]
[# comments]

Note: Although we have presented the fields on different lines in this 
document, all of the fields in a NAF record are part of the same line. 

where:

-em indicates an NA record for a Passport node.

<module_name> is the name of the node.

-sdfile is the keyword for specifying the View name. When specified, 
this keyword needs to be followed by the <mode> and <name> parameters.

<mode> is one of keyed, dated, or user-specified.

<name> is the name of a valid key, a valid date in the format yymmdd, or 
a View name.

-critical indicates that the View is critical.
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-activate indicates that the View is to be activated.

-commit indicates that the View is to be committed.

-pause indicates that automatic pause is to be used. When this option is 
specified, a Pause option is passed to the activate command line and a pause 
is forced before the software migration.

-noPause indicates that automatic pause will be disabled. When this 
option is specified, a no Pause option is passed to the activate command line 
and the software migration activation does not pause before migration 
switchover.

-timeout indicates the activation timeout period. When specified, this 
keyword needs to be followed by the <minutes> parameter. When not 
specified, the timeout period defaults to 50 minutes.

-verify_date specifies that date verification is to be performed. When 
this option is specified, the date of the View is verified before activation to 
ensure that the date is later than that of the current View. The current View 
also needs to be assigned the Dated mode of activation. 

-pre is the keyword for specifying to run the pre-activation script. When 
this option is specified, this keyword is usually followed by the <-pre_scr> 
parameter.

-pre_scr <script_list> is a list of “\;” terminated commands 
representing the pre-activation scripts to be invoked and their command line 
arguments.

-post is the keyword for specifying to run the post-activation script. 
When this option is specified, this keyword is usually followed by the 
<-post_scr> parameter.

-post_scr <script_list> is a list of “\;” terminated commands 
representing the post-activation scripts to be invoked and their command line 
arguments.
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<#comments> are comments applicable to the record. Anything after a 
pound (#) sign is treated as a comment.

Sample of a Network Activation File
The following is a sample NAF:

-em ROME -sdfile keyed West1 -critical -activate -
commit -timeout 50 -pause -pre -pre_scr /opt/
MagellanNMS/cfg/macros/user/scr1 opt1 opt2 opt3 \; /
opt/MagellanNMS/cfg/macros/user/scr2 opt1 opt2 \; -
post -post_scr /opt/MagellanNMS/cfg/macros/user/scr3 
\; /opt/MagellanNMS/cfg/macros/user/scr4 opt1 \;

Pre- and Post-activation scripts
Pre-activation scripts verify and modify the Passport node configuration 
before activation is performed and prevent activation if an error code is 
returned. Post-activation scripts, executed after the activation, allow the 
activation to be verified, and return error conditions, if necessary. 

Multiple scripts can be configured, and scripts are executed one at a time. 
Scripts are logged in a temporary file during the execution of scripts, but then 
are merged into the NAT log file once the execution is completed. 

If a fatal error occurs in one of the pre-activation scripts, the process is 
stopped and the record turns red, indicating a major error. If a warning occurs, 
the process continues and the next (if any) scripts are run. 

If a fatal error occurs in a post-activation script, any remaining post-activation 
scripts are not run, and the records turn yellow, indicating a minor error. If a 
warning occurs, the process continues and the next record (if any) is run. The 
record turns blue even if there are warnings, since the process did not fail. The 
log file indicates if a script has completed with warnings.

If a specified script cannot be run due to permissions or does not exist, the 
process stops and the record turns red, indicating a major error. See “Color 
indicators” (page 113). 

Pre- and post-activation script rules
Pre- and post-activation scripts must follow certain rules:

• the exit code must be 0 to be considered successful by the NAT
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• the exit code must be 1 to be considered fatal by the NAT

• an exit code of anything other than 0 or 1 is a warning

• logging must be performed on stdout for information or stderr for errors 
so the NAT can capture it

• node names and view names must be retrieved through an environment 
variable if not specified on the command line ($DNAME: module name 
(format: EM ROME) and $NAT_VIEWNAME: view-type viewname 
(where view-type can be KEYED, DATED, or USER_SPECIFIED)). 
The node name and view name are set from the data available in the NA 
record.

• NAT also provides access to the session “display” 
($NAT_SESSION_DISPLAY) and the real display 
($NAT_UI_DISPLAY).

• the scripts can invoke GUIs, but only when NAT is run in graphical 
mode.

The pre-activation scripts are run PRIOR to activation while post-activation 
scripts are run after the activation and commit, if a commit is specified. If a 
commit has not been specified, the commit should be invoked within one of 
the post-activation scripts.

For each activation record, scripts are run one at a time before or after 
activation. If a post-activation scripts fails, another script is not run for that 
record and a warning is issued. If a post-activation scripts ends with a 
warning, then the next remaining post-activation script is run for that record, 
and a warning is indicated in the log file for that record.

If you are using your own scripts, it is recommended that they be stored in:
/opt/MagellanNMS/cfg/macros/user directory. This directory is added to the 
PATH prior to script execution.

For customized module access, the GROUP connection management can be 
overridden with a customized script. The customized authentication script 
must be /opt/MagellanNMS/cfg/macros/user/NAT_authenticate. If the script 
is found, it is executed and returns a 0 on success. The script establishes the 
GROUP connection so NAT does not attempt to connect again. If the 
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customized script fails, the user is prompted for authentication information as 
before. The Group authenticate selection is still available from the Security 
menu, if the script exists.

NAT logs summary
The following logs are issued when scripts are run:

• Executing <script name>. Issued when a script is launched.

• <script name> has completed successfully. Successful execution.

• <script name> has completed but errors were found. Execution failed.

• <script name> has completed successfully with warnings. Successful 
execution with warning(s).

• <script name> could not be found. Execution failed.
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Network Activation main window
The Network Activation window contains a menu bar, a working area, and a 
Messages area. See the figure “Network Activation main window” 
(page 108).

Figure 5
Network Activation main window

The working area displays a list of Network Activation (NA) records and 
contains three buttons for rearranging the order of records in the list and for 
executing them. The Messages area is used to display status or error 
information.

See the following sections for information on the parts of the Network 
Activation main window:

• “Menu bar” (page 109)

• “Working area” (page 111)

• “Messages area” (page 116)
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Menu bar
The menu bar is located at the top of the Network Activation main window. 
See the following sections for information on the menu bar entries:

• “File menu” (page 109)

• “Edit menu” (page 109)

• “Options menu” (page 110)

• “Security menu” (page 110)

• “Help menu” (page 110)

File menu 
The File menu commands are as follows:

• Load loads records from a network activation file (NAF) into the record 
list. This command opens the Load NAF dialog in which you specify the 
NAF to load. If the record list has any records displayed in it, a 
confirmation dialog opens and prompts for permission to clear the list 
before loading the NAF.

• Save saves new or modified records to a NAF. If there are no additions 
or changes in the record list to be saved, or if you have not loaded a NAF, 
this command is disabled (grayed out).

• Save As saves records to a specified NAF. This command opens the Save 
NAF dialog for specifying the full path name of the NAF. If there are no 
entries in the record list, this command is disabled.

• Exit closes all windows and closes the tool.

Edit menu 
The Edit menu commands are as follows: 

• Add DPN Record is not applicable to a Passport node.

• Add Passport Record adds a Passport node record to the record list. This 
command opens the Passport Edit dialog for entering the data. The new 
record is added after the record that is being pointed at (the record 
surrounded by the box with a dashed line).
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• Clear removes all records from the record list. If the list has been 
modified but not saved, a confirmation dialog opens to obtain 
confirmation of the clear.

Options menu
The Options menu commands are as follows:

• DPN Preferences opens the DPN Preference dialog. This dialog is not 
applicable to a Passport node.

• Passport Preferences opens the Passport Preference dialog. This dialog 
is used for entering the preferred values for a new record.

• Save Preferences saves, for future sessions, any changes you made in the 
Passport Preference or DPN Preference dialogs.

Security menu 
The Security menu commands are as follows:

• Group Authenticate opens the Passport Group Authentication dialog to 
perform authentication for accessing a group of Passport nodes. 
Although you can authenticate with more than one group, only the last 
group you authenticated with is active. 

• NCS Authenticate opens the DPN Authentication dialog. This dialog is 
not applicable to a Passport node.

Help menu
The Help menu commands are as follows: 

• On Context lets a user obtain help information for an item in the NAT 
main window. Choosing this command changes the cursor to a question 
mark. Moving the question mark to an item in the window and clicking 
the select button provides help information about the item selected.

• On Help displays help text about how to use the help facility. 

• On Window displays help text about the application main window and its 
general contents. 
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• On Keys displays help text about the function keys, mnemonics, and 
keyboard accelerators. The accelerators are as follows:

Ctrl + L = Load

Ctrl + S = Save

Ctrl + A= Save As

Ctrl + E = Exit

Ctrl + G = Group Authenticate

Working area
The working area of the NAT contains a Network Activation (NA) record list 
that uses color indicators to indicate the status of network activation. The 
record list also supports a pop-up menu and contains three action buttons. For 
descriptions of these items, see:

• “NA record list” (page 111)

• “Color indicators” (page 113)

• “Pop-up menu” (page 114)

• “Up and down arrow buttons” (page 114)

• “Execute button” (page 115)

NA record list
The NA record list displays Network Activation (NA) records. The content 
of the records and their order in the list can be modified using commands and 
action buttons. See also:

• “Pop-up menu” (page 114)

• “Up and down arrow buttons” (page 114)

• “Execute button” (page 115)

You can select a set of records in the NA record list for execution. While 
execution is in progress, fields in the records change color to indicate the 
execution status. See also: “Color indicators” (page 113). 
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The NA record list contains the following fields:

• CR indicates (YES|NO) whether the View is critical. 

Critical records are executed first, one at a time, in the order in which 
they appear in the list. Then the non-critical records are executed. If a 
critical record cannot be executed, the tool stops and does not execute the 
next record.

• Module displays the module name in the format EM/<Passport name>. 
Module names that begin with PM are not applicable to Passport.

• MCF/View Mode indicates the method used for accessing the View. The 
mode is one of:

K access with a key

D access by date

U access according to a user-specified information

• MCF/View Name indicates the name of the key, the date, or the View 
used for activation or committing.

• NMS Disk is not applicable to a Passport node and is always set to “-”.

• RDS/SDS is not applicable to a Passport node and is always set to “-”.

• Date Verify indicates whether date verification is to be performed on a 
View that is to be activated by date. When Date Verify is set to YES, the 
date of the View is checked against the date of the current View. If the 
View has a dated key that predates the current View, activation fails and 
the record turns red. 

• Loaders Commit is not applicable to a Passport node and is always set to 
‘-’.

• MCF/View PreAct indicates whether pre-activation scripts are to be run.

• MCF/View Act indicates whether the View is to be activated.
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• MCF/View -Pause indicates whether the automatic pause is to be used. 
When -Pause has the value “-”, it means that no option is passed to the 
activate command line. When -Pause is set to YES, a -Pause option is 
passed to the activate command line. When -Pause is set to NO, a 
-noPause is passed to the activate command line.

• MCF/View Commit indicates whether the View is to be committed.

• MCF/View PostAct indicates whether post-activation scripts are to be 
run.

The NA record list is a multi-select list, which means you can select more 
than one record at a time. 

The NA record list also supports double-clicking. Double-clicking on a 
record that has not been executed selects the record and opens a dialog for 
viewing or editing the record. Double-clicking on a record that has been 
executed selects the record and opens a dialog that displays log information 
about execution of the record.

Color indicators
Different colors are used to indicate the status of the NA records. The colors 
and their meanings are as follows:

• No color means the record is ready for execution.

• Blue means the record has been executed successfully.

• Green means execution is in progress. When a specific action is being 
performed, the corresponding field turns from blue to green. If the action 
completes successfully, the field turns from green to blue and the next 
field turns green. When all actions on a record are completed 
successfully, the entire record turns blue. If an action fails, the entire 
record turns red or yellow, according to the severity of the error.

• Yellow means that a minor error was found during execution or that 
execution was interrupted by the user.

• Red means a major error was found during execution. This record can 
only be re-executed if the user resets the state manually. 
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After execution is complete, a user can reset the color of the records back to 
no color in preparation for re-execution by means of the Reset command. This 
command is available in the record list pop-up menu.

Pop-up menu
The record list is equipped with a pop-up menu that contains the following 
commands:

• Edit opens the Passport Edit dialog for viewing or editing a record that 
is selected in the record list. The module name cannot be changed during 
the edit.

• Use Preferences applies values that were pre-defined in the Passport 
Preference dialog to records that are selected in the record list.

• Add DPN Record is not applicable to a Passport node.

• Add Passport Record opens the Passport Edit dialog for entering a new 
record. The new record is added below the highlighted record. 

• Delete deletes records that are selected from the NA record list. A 
confirmation dialog opens and prompts for permission to perform the 
deletion.

• Show Status opens a dialog that shows execution information for a record 
that is selected in the NA record list. This command is only enabled if the 
record has been executed.

• Reset changes the state of selected records bask to their initial state then 
deselects the records. This allows the records to be re-selected and re-
executed, regardless of their previous state.

• Select All selects all records in the NA record list.

• Deselect All deselects all selected records.

Up and down arrow buttons
The up arrow button moves records that are selected in the NA records list 
upwards towards the top of the list. The down arrow button moves them 
downwards. You can select more than one record at a time to move up or 
down.
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The up and down arrows are especially useful for rearranging records to 
change their execution order, or for reducing the number of times you need to 
authenticate to execute all of the records in the record list.

Critical records in the record list are always executed first, one at a time, in 
the order in which they appear in the list, followed by the non-critical records. 
You can rearrange the critical records with the arrows to specify the order in 
which the critical records, followed by the non-critical records, are executed.

With the Network Activation Tool, you can only execute records for the 
nodes in one group at a time. On occasion, records may apply to modules that 
belong to different groups. To execute all of the records, you have to 
authenticate with the groups as needed. You can use the arrows to group all 
the records for one group together, minimizing the number of times you need 
to authenticate.

The up and down arrows are disabled unless at least one record is selected in 
the list.

Execute button
The Execute button executes the records that are selected in the NA record 
list.

When you click Execute, a confirmation dialog opens and displays the list of 
modules on which the actions are to be performed, prompting for 
confirmation. For more information, see “Confirmation dialog” (page 132).

Clicking OK in the confirmation dialog opens an Execution dialog for 
specifying the parameters for the execution. Once you have set up the 
execution parameters in the Execution dialog, clicking on the Execute button 
starts execution of the records. For more information, see “Execution dialog” 
(page 129). 

When execution of a record begins, the entire record turns blue. Then, as each 
step in the execution takes place, the field associated with the step turns from 
blue to green. If the step is successful, the field turns from green to blue, and 
the next field turns green. If all steps in are executed successfully for a record, 
the entire record turns blue. If a step fails, the entire record turns red or yellow, 
according to the severity of the failure.
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While execution is underway, the Execute button is replaced by a Stop button 
that can be used to halt execution. Halting execution turns the record in which 
execution was halted to yellow and launches the Processing dialog (see 
“Processing dialog” (page 131).

Records in the record list are executed as follows:

• Red, yellow, or blue color records are not executed.

• Critical records are executed first, one at a time, in the order in which 
they appear in the record list.

• Non-critical records are executed after critical records, also in the order 
in which they appear in the list.

• If execution of a critical View fails, the tool stops and does not execute 
the next record.

• Records are only executed for the group whose authentication is 
currently active. That is, the group that has most recently been 
authenticated by selecting Group Authenticate... from the Security menu.

Messages area
The Messages area displays execution status information and error messages. 
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Network Activation dialogs
See the following sections for information on Network Activation dialogs:

• “Load NAF dialog” (page 118)

• “Save NAF dialog” (page 120)

• “Passport Edit dialog” (page 121)

• “Passport Preference dialog” (page 125)

• “NAT Edit Script dialog” (page 126)

• “Authentication dialog” (page 29).

• “Execution dialog” (page 129)

• “Processing dialog” (page 131)

• “Confirmation dialog” (page 132)

• “Log information dialog” (page 133)

• “Error dialog” (page 133)

• “Warning dialog” (page 133)

• “Pause dialog” (page 134)

The following dialogs can be accessed from Network Activation, but are not 
applicable to Passport nodes:

• DPN Edit dialog

• DPN Preference dialog

• NCS Authentication dialog
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Load NAF dialog
The Load NAF dialog lets you specify the name of a NAF file that contains 
records to be loaded into the NA record list. See the figure “Load NAF 
dialog” (page 118).

Figure 6
Load NAF dialog

The dialog contains the following items:

• a Filter field for specifying the path to the directory that is to be used as 
a starting point for finding the NAF to load

The subdirectories of the directory specified in this field are displayed in 
the Directories panel of the dialog when you enter a carriage return in 
this field, or when you click the Filter button.

• a Directories panel for displaying the available subdirectories of the 
directory specified in the Filter field

• a Files panel for displaying the available files of the directory selected in 
the Directories panel
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• a Network Activation File field for specifying the full path name of the 
NAF to be loaded

You can specify the name of a NAF to be loaded in one of two ways: by 
entering its full path name in this field; or, by entering information in the 
Filter field, selecting a directory in the Directories panel, and selecting a 
file in the Files panel.

• a Load button for loading the NAF specified in the Network Activation 
File field into the NA record list

• a Filter button for updating the Directories panel, the Files panel, and the 
Network Activation File field according to the pathname entered in the 
Filter field

• a Cancel button for aborting the load and closing the dialog

• a Help button for displaying help information about the dialog
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Save NAF dialog
The Save NAF dialog lets you specify the full path name of a NAF in which 
to save new or modified records from the NA record list. See the figure “Save 
NAF dialog” (page 120).

Fields, panels, and buttons in the dialog are similar to those in the Load NAF 
dialog. See also: “Load NAF dialog” (page 118).

Figure 7
Save NAF dialog
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Passport Edit dialog 
The Passport Edit dialog lets you specify the information and actions for a 
new Passport node record that is to be added to the NA record list, or to 
modify an existing record that is selected in the NA record list. Information 
in the dialog applies to one View. See the figure “Passport Edit dialog” 
(page 121).

Figure 8
The Passport Edit dialog

Double-clicking on an existing record opens the Passport Edit dialog that 
contains the data from the record. From this dialog, you can change any 
parameters and actions, except the module name displayed in the EM field.
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If you select Add Passport Record from the File menu or from the NA record 
list pop-up menu, the Passport Edit dialog opens with the data defined in the 
Passport Preference dialog and the EM field empty. If no preferences have 
been set, the following defaults are used:

EM data entry field Empty

Critical NO

Keyed NO

Dated NO

User Specified YES

Data entry field Empty

Check against current view NO

Run pre-activation scripts NO

Activate NO

-noPause NO

-pause NO

Commit NO

Run post-activation scripts NO

Confirm Retry 5

Comments Empty
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The Passport Edit dialog contains the following items:

• an EM data entry field for specifying the node name 

If you are editing an existing record, the EM field displays the node name 
associated with the record you are editing. You cannot modify this name 
while editing an existing record.

• a Passport View Parameters panel for specifying parameters associated 
with the target View, which consists of:

— A Critical check button to indicate whether the action to be executed 
is critical or non-critical

— a set of radio buttons labelled Keyed, Dated, and User specified, and 
a data entry field, which together specify the View access mode.
If you select Keyed, the label of the data entry field changes to Key 
and you need to enter the name of a valid key for the View.If you 
select Dated the label changes to Date and you need to enter 
date for the View in the format yymmdd. If Dated is selected as a 
preference in the Passport preference dialog, the current date 
appears in the field. However, if Date is not selected as a preference 
and you click Dated, the Date field appears but is blank. To put the 
current date into the Date field, click the Dated radio button again. 
See “Date Convention” (page 25) for more information on the date 
format.
If you select User specified, the label changes to View and you need
to enter a valid View name.

— a check button labelled Check against current view for specifying 
whether the date is to be verified against the date of the current View 
before activating or committing.
If you select this button, the date of the View is verified against the
date of the active View. 
If the date specified is earlier than that of the active View, execution 
of the record fails.
This check button is only enabled when the Dated mode is selected.

• a check button labelled Run pre-activation scripts for specifying if pre-
activation scripts will be run.

• an Edit button that opens the Edit Pre-activation scripts dialog for 
creating or editing the pre-activation scripts.
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• a check button labelled Activate for specifying if the activate action is to 
be performed

• a check button next to the Activate button, labelled -noPause. Checking 
the -noPause option disables the automatic pause that typically occurs 
before a migration switchover during a hitless software migration.

• a check button next to the noPause button, labelled -Pause. Checking the 
-Pause option enables the automatic pause that typically occurs before a 
migration switchover during a hitless software migration.

• a set of check button labelled Commit for specifying if the commit action 
is to be performed

• a check button labelled Run post-activation scripts for specifying if post-
activation scripts will be run.

• an Edit button that opens the Edit Post-activation scripts dialog for 
creating or editing the post-activation scripts.

• a data entry field labelled Confirm Retry for specifying the retry times for 
confirmation

• a text area labelled Comments for adding user comments

• a text area labelled Messages for displaying messages about attempts to 
add or modify information in the dialog

• an OK button that is used to add or replace the record in the list and close 
the dialog

If you fail to enter information in a required field, an error icon (X) 
appears beside the corresponding field in the dialog and a message 
indicating the nature of the error appears in the Messages panel. You 
need to enter the correct information in the field before the dialog will 
close and the record can be added or saved.

• a Cancel button that closes the dialog without saving any additions or 
changes

• a Help button that displays help information about the dialog
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Passport Preference dialog 
The Passport preference dialog lets you specify:

• the default data to be used for adding a new Passport node NA record to 
the record list

• the values to apply to records that are selected in the record list when you 
choose the Use Preferences command from the record list pop-up menu

The Passport preference dialog is identical to the Passport Edit dialog, except 
that:

• The EM field and the Comments and Messages text fields are absent.

• The OK button sets the preferences values for the current session and 
closes the dialog.

See also: “Passport Edit dialog” (page 121).
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NAT Edit Script dialog
The NAT Edit Script dialog lets you enter script names with command-line 
arguments in a specified order in which the scripts will be executed. This 
dialog is invoked from the Passport Record dialog or the Passport Preferences 
Dialog.

For a new record, the NAT Edit Script dialog opens with the data defined in 
the Passport Preference dialog. If preferences have not been set, defaults are 
used. 

If the NAT Edit Script dialog is opened from the Passport Preferences dialog, 
then there is an additional button called Apply to current Passport node 
records. When this button is selected, the script list contained in every record 
in the NA record list is replaced with the current script list defined in the top 
text area.

The NAT Edit Script dialog contains the following items:

• a text area listing the command line for each script selected to be run

• a Name data entry field for specifying the complete path name of the 
script (the default is empty)

• an Options data entry field for specifying the command line option for 
the script (default is empty)

• a Browse button that opens a File dialog for searching and selecting a 
script. You can use the Browse button to select the script name instead of 
typing it in the Name Data Entry field

• An Add button that is enabled when the Name field is not empty. The 
Add button causes the script name and options in the Option field to be 
added to the list of scripts.

• A Delete button that is enabled when a script is selected in the list of 
scripts at the top text area. The Delete button causes the script to be 
deleted from the list of scripts.

• A Replace button that is enabled when a script is selected in the list of 
scripts at the top text area and the Name field is not empty. The Replace 
button causes the selected script to be replaced by the script and options 
in the Name and Options data fields.
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• An Up arrow button that moves a script that is selected in the script list 
up towards the top of the list. The Up arrow button is disabled unless a 
script is selected that is not at the top of the list.

• An Down arrow button that moves a script that is selected in the script 
list downwards to the bottom of the list. The Down arrow button is 
disabled unless a script is selected that is not at the bottom of the list.

• An Apply to current Passport records button (only available when 
opened from the Passport Preferences dialog) that is used to replace the 
script list contained in every NA record with the current script list 
defined in the top text area of the dialog.

• An OK button that is used to update the script list in the record and close 
the dialog.

• A Cancel button that closes the dialog without making any additions or 
changes.

• A Help button that displays help information about the dialog.
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Figure 9
NAT Edit Script dialog
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Execution dialog
The Execution dialog lets you specify parameters such as the working 
directory and the number of processes for executing NA records. See the 
figure “Execution dialog” (page 129).

Figure 10
Execution dialog

The Execution dialog contains the following items:

• a Working Directory field for specifying the directory for storing working 
files that are created while the tool is running. 
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• a Number of Processes field for specifying the number of non-critical 
records in the list on which execution can be performed simultaneously. 
The default is 1.

The number to specify depends on the amount of memory available on 
the workstation. The higher the number, the more memory is used.

This parameter only applies to non-critical records. For critical records, 
only one record is executed at a time, regardless of the number you 
specify for this parameter.

• a Log to File check button for specifying whether information about the 
execution is to be captured in a log file

If this button is not selected the panels, fields, and buttons in the log file 
specification area are disabled (grayed out). The default is no log file.

• a Log File specification area that is used to specify the full path name of 
a log file for log messages that are produced during the execution. 

The log file specification area consists of the following items:

— a Filter field for specifying the path to the directory that is the 
starting point for choosing the directory in which to store the log file 
The subdirectories of the directory specified in this field are 
displayed in the Directories panel when you enter a carriage return 
in this field or when you click the Filter button.

— a Directories panel for displaying the available subdirectories of the 
directory specified in the Filter field

— a Files panel for displaying the available files of the directory 
selected in the Directories panel

— a Log File Name field for specifying the full path name of the log file 
to be stored
You can specify the name of a log file in two ways: by entering its 
full path name in this field; or, by entering information in the Filter 
field, selecting a directory in the Directories panel, and selecting a 
file in the Files panel. The default is nat.log in the user’s home 
directory.
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— a Filter button for updating the Directories panel, the Files panel, 
and the Log File field according to the pathname entered in the Filter 
field

• an Execute button for executing the action based on the information

• a Defaults button that resets all items in the dialog back to their default 
values

• a Cancel button that closes the dialog without performing the execution 
or saving the execution parameters

• a Help button that displays help information about the dialog

Processing dialog
The Processing dialog opens if you click on the Stop button in the Network 
Activation Tool window while execution is underway. This dialog displays 
the message Stopping all execution processes, please wait to indicate that no 
further user action is permitted until all execution software processes are 
terminated, at which time the dialog closes.
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Confirmation dialog
The confirmation dialog prompts you for confirmation before the software 
takes the next step:

• When you click Execute in the NAT window, the dialog displays 
information about the records to be processed and asks you for 
permission to continue.

• When you select Delete from the record list pop-up menu, the dialog 
prompts for confirmation to remove the selected record.

• When you select Exit without saving new records to a NAF, the dialog 
asks if you really want to exit without saving.

Buttons in the dialog are as follows:

• OK continues the execution.

• Cancel closes the dialog without performing the execution.

• Help displays information about the dialog.

See the figure “Sample confirmation dialog for confirming execution” 
(page 132).

Figure 11
Sample confirmation dialog for confirming execution
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Log information dialog
The log information dialog displays status information for a record that has 
been executed. To display the information, double-click on an executed 
record in the record list; or, select the log in the record list and choose Show 
Status from the record list pop-up menu.

For an illustration of the Log information dialog, see the window “Sample log 
information dialog” (page 133).

Figure 12
Sample log information dialog

Error dialog
The Network Activation error dialog displays a message to indicate why an 
action cannot be performed. Once you have read the message, click OK to 
close the dialog. Then, correct the source of the error and try the action again.

Warning dialog
The Network Activation warning dialog displays a message to indicate the 
consequences of the action you are about to take. This dialog also prompts 
you for confirmation of the action.

Buttons in the dialog are as follows:

• OK closes the dialog continues the action.

• Cancel closes the dialog without performing the action.

• Help displays information about the dialog.
Preside MDM Configuration Management for Passport User Guide   15.1RSUP



134   Chapter 4 Network Activation
Pause dialog
The Pause dialog displays a message to indicate why the software migration 
has been paused. This dialog also prompts you to confirm one of the 
following actions:

• Continue continues the software migration.

• Stop stops the software migration.
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Global Data Manager

This section describes the Global Data Manager command line tool and the 
procedures for using it. In this section, you can find the following 
information:

• “The Passport Global Data Manager tool (pgdm)” (page 135)

• “Starting the Global Data Manager tool” (page 135)

• “Pgdm input files and operations” (page 136)

• “The Global Data Manager command line” (page 141)

• “Cron job” (page 143)

• “Global Data Manager procedures” (page 143)

The Passport Global Data Manager tool (pgdm)
You can use the Passport Global Data Manager tool to propagate global data 
components from a Passport node to other selected nodes. Pgdm also replaces 
the attribute values for those components during propagation. In addition, 
pgdm can be used to replace the attribute values for selected nodes in the 
network.

By allowing data to be copied and propagated, pgdm enables you to 
efficiently provision global data and to replace attribute values globally. 
Pgdm also reduces the risk of errors due to mistakes in keying in service data.

Starting the Global Data Manager tool
Pgdm is started from a UNIX window. You can also invoke the pgdm 
command line directly through a cron job.
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See also...

• “The Global Data Manager command line” (page 141)

• “Cron job” (page 143)

Pgdm input files and operations
When you use pgdm, the first thing you should do is create the two main input 
files, the component file and the module name file. The module name file 
contains the source and target Passport nodes, and associated provisioning 
view to be loaded and saved. The component file specifies the data 
components to be propagated (such as Userid, Voice Networking Call Server 
[Vncs], and Voice Profiles [Vp]) and the attributes to be replaced. Based on 
information provided in both input files, pgdm determines the operation that 
needs to be performed.

See the table “Pgdm input files and operations” (page 136).

Also, an optional pre-propagate input file contains the on-switch add/set/
delete commands that are sent down to the target node before the propagation.

Table 1
Pgdm input files and operations

Module name 
file

Component file Operation

Source and 
target(s) 

Components 
only

Propagate the specified components 
from the source to the targets

Source and 
target(s) 

Components 
and attributes

Propagate the specified components 
from the source to the targets. During 
propagation, the attribute values are 
replaced by the new values specified in 
the component file.

Target(s) only Components 
and attributes

Replace the attribute values for 
specified components. Save the 
modified view on the same node.

As result, the attribute values of 
specified component are the same for 
all selected targets.
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Module name file
The module name file specifies the source Passport node where the data 
components are retrieved and the target nodes for propagating. You can use 
any type of NMS-supported upload (User specified, Committed, Current, 
Keyed, Dated) or download (User specified, Keyed, Dated) to determine the 
provisioning filename. The module name file consists of at least one target 
record. You do not need to specify the source record; otherwise, specify only 
one source record at a time. 

A record can span more than one line; a \ character is used as a line 
continuation indicator. You can also use comment lines (lines beginning with 
‘#’) in the module name file. 

Source 
The source Passport node record is specified using the following format:

-source <passport_name> -uploadmode [Current | Committed\ 

| Keyed <key> | Dated <date_key> | User_specified\ 

<view_filename>]

where:

-source uses <passport_name> to specify the name of the node where the 
global data is obtained.

-uploadmode specifies, by the keyword that follows, how to construct the 
name of the provisioning view to be loaded.

Note: If the source node is not specified, pgdm uploads the provisioning 
view from the target, applies the changes specified in the component file, 
and downloads the modified view back to the same target.

Target 
The target Passport node records are specified using the following format:

-target <passport_1>...<passport_n> -uploadmode [Current\ 

| Committed | Keyed <key> | Dated <date_key> \

| User_specified <view_filename>] -downloadmode \

[Keyed <key>| Dated <date_key> | User_specified \ 

<view_filename>]
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where:

-target uses the variables <passport_1>...<passport_n> to specify the 
names of nodes to which the global data are populated.

-uploadmode specifies, by the keyword that follows, how to construct the 
name of the provisioning view to be loaded.

-downloadmode specifies, by the keyword that follows, how to construct 
the name of the new provisioning view to be saved.

Example
The following is an example of a module name file that can be used to 
propagate the global components from a source node to other selected nodes.

# Upload the Committed view from noder10.
-source noder10 -uploadmode Committed
# Propagate the specified components to noder16,
# noder17, noder18, node19, node20, and node21 using 
# the “myviewfile”. 
# The modified view is then saved using the NMS key.
-target noder16 noder17 noder18 node19 node20 node21 \
-uploadmode user_specified myviewfile -downloadmode
 Key NMS
# Also, propagate the specified components to noder10,
# noder11 using the NMS key.
-target noder10 noder11 -uploadmode Key NMS 
-downloadmode Key NMS

Component file
The component file specifies the components and their new attribute values. 
In general, a component and the attributes to be replaced can be specified 
using the following format:

<comp_1>{/<key>}... <comp_n>{/<key>} @<attr_1> 

<value>,...,<attr_n> <value>

where:

<comp_n> is the name of the component, for example, Vncs or Vp.
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<key> is the component instance value. A wildcard (*) can be use to 
specify all   instances.

<attr_n> is the name of the attribute to be replaced.

<value> is the new attribute value of a specified attribute.

The component file rules are as follows:

• If pgdm is used to replace attribute values globally (that is, no source is 
specified in the module name file), you need to specify the attribute name 
and its new value. 

• If pgdm is used to propagate a global data component, you can omit the 
attribute part.

• If the ancestors of Comp_n do not exist on the target node, an error 
message is generated during loading of the partial file by the target node.

• You need to enter the component and associated attribute values on one 
line.

Example
The figure “Vncs hierarchy” (page 140) shows the hierarchy of the 
VoiceNetworkingCallServer (Vncs) and VoiceProfile (Vp) components.
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Figure 13
Vncs hierarchy

To propagate all Vncs components, type the following line in the component 
input file:

 Vncs/*

To propagate Vp/1, type the following line in the component input file:

Prof Vp/1

To propagate all Vp components, you can specify the following line in the 
component input file:

Prof Vp/*

Example
The component file contains the following three lines:

FrNni/* Dna @outDefaultPathReliability  
high,numberingPlanIndicator x121

FrNni/10 Dna @numberingPlanIndicator e164

Trk/* UnAcked @maximumErroredInterval 0

AC - Access Code
Dn - Data Network
Prof - Profiles
Vcns - Voice networking Call Server
Vp - Voice Profile

Root

Vncs/1 Prof

Vp/1
Ac/noAccessCode Ac/AccessCode 1 Ac/AccessCode 2

Dn/<n> Dn/<n>
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In this example the outDefaultPathReliability attribute value is set to high and 
the numberingPlanIndicator is set to x121 for all FrNni components. The 
exception is FrNni/10 where the numberingPlanIndicator is set to e164. Also, 
the maximumErroredInterval attribute of all Unacked Trk is set to 0.

Example
The component file contains the following line:

Ac Userid/newUser

In this example, the newUser data is retrieved from a source node. This data 
is then added to all target node provisioning views specified in the module 
name file.

Pre-propagate command file (optional)
The global data propagation can require some changes to the components 
before loading the new partial file on the Passport node. The changes can be 
adding components, deleting components, or setting components to a 
particular value. The on-switch provisioning add/set/delete commands can be 
specified in an input file. In the input file, one command is entered on one 
line. The pgdm tool then sends all the commands to the target node before 
loading the new partial file. 

Example
delete Vncs/1

The Global Data Manager command line
Pgdm is invoked from a UNIX window. (See “Accessing UNIX” (page 28) 
for more information.) Pgdm uses the NMS provisioning view naming 
convention (that is, UserSpecified, Key, Dated, Current, Committed, and so 
on). This convention is used to determine the provisioning view to be 
uploaded and saved.

The format of the pgdm command and the description of its parameters and 
options are as follows:

pgdm -auth <group_name> <user_id> <password> \

[-modf <module_fn>] \

[-compf <component_fn>] \

[-pcmdf <pre-propagate_fn>] \

[-logfile [log_fn] \
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[-wd <working_dir>] \

[-quiet] \

[-np <number of processes>]

where:

-auth is the authentication flag. The following parameters are used to log 
in to the source and target nodes:

<passport_group_name> Mnemonic of the group to log on to.
<userId> Node user ID to logon with.
<password> Password for the user ID.

-modf is the module name file flag. The following variable is the name of 
the module name file:

< module_filename> The name of the file that specifies the nodes and 
associated view filename for uploading and downloading. The filename is 
case sensitive.

-compf is the component file flag. The following variable is the name of the 
component file:

<component_filename> The name of the file that specifies the components to 
be propagated. The filename is case-sensitive.

-pcmdf is the pre-propagate command file flag. The following variable is 
the name of the pre-propagate command filename:

<pre_propagate_filename> The name of the file that contains the on-switch 
commands to be applied to the target node before loading the new partial file.

-logfile indicates that a log file other than the default is to be used. The 
following parameter is optional:

<log_fn> The name of the log file to use if other than the default.
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Note: A log file is always generated. The default is ‘$HOME/
pgdm<pid>.<yymmdd>_<hhmmss>.log’, where:
<pid> is the process ID.
<yymmdd> is the date.
<hhmmss> is the time.

-wd is a flag that shows that a specified directory is used to store the default 
log file and other intermediate files.

<working_dir> The working directory name.

-quiet indicates no log file messages are generated. Error messages are 
output to stderr.

-np is a flag used to indicate the number of target nodes to be processed in 
parallel. By default, the target nodes are processed sequentially. The 
following parameter is used for processing nodes in parallel:

<number of processes> Number of target nodes to be processed in parallel.

Cron job
Since pgdm starts up all the session servers (cmcfun and CM), you can invoke 
the pgdm command line directly by using the UNIX cron facility.

See 241-6001-304 Preside MDM Configuration Management for DPN 
Administration, for more information on running a cron job.

Global Data Manager procedures
See the following sections for information on procedures you can perform 
using pgdm:

• “Propagating components” (page 144)

• “Removing components during propagation” (page 146)

• “Globally replacing attribute values” (page 147)
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Propagating components
Pgdm is used to propagate global data components or to replace the attribute 
values for those components during propagation. The procedure involves the 
following steps, which are illustrated by specific examples.

1 Create a module name file (see “Module name file” (page 137)). This file 
contains one source node record and a number of target records, and has 
the following format.

-source <passport_name> -uploadmode [Current |
Committed\ | Keyed <key> | Dated <date_key> |
User_specified <view_filename>]

-target <passport_1>...<passport_n> 
-uploadmode [Current | Committed | Keyed <key> |
Dated <date_key> | User_specified <view_filename>]
-downloadmode [Keyed <key> | Dated <date_key> |
User_specified <view_filename>]

2 Create a component file (see “Component file” (page 138)). This file 
contains the components that you wish to propagate. You can specify the 
component’s attribute values if they need to be changed. The file has the 
following format:

<comp_1>{/<key>}... <comp_n>{/<key>} @<attr_1> 
<value>,...,<attr_n> <value>

3 Invoke pgdm (see “The Global Data Manager command line” (page 141)) 
by using the following format:

pgdm -auth <group_name> <user_id> <password> \
[-modf <module_fn>] \
[-compf <component_fn>] \
[-pcmdf <pre-propagate_fn>] \
[-logfile [log_fn] \
[-wd <working_dir>] \
[-quiet] \
[-np <number of processes>]

Example 1: Adding a new user for nodes in the network
Add a new user as follows:

1 Add a new user, GUEST, into a Passport node View using the 
Downloadprovisioning tool. This node is referred to as the source where 
the new user data is obtained.
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2 Create a module file. In this file, specify the source (NODE1) and the 
targets. Use the uploadmode DATED for both uploading and 
downloading.

-source NODE1 -uploadmode DATED 960520

-target NODE2 NODE3 -uploadmode DATED 960520 -
downloadmode DATED 960521

3 Create a component file that contains the following line:

Ac Userid/GUEST

 Where GUEST is the <newUser> created in step 1.

4 Type the following command to capture the output messages into the 
logfile mylog:

pgdm -auth PPgroup myId myPasswd -modf modules -compf
comps -logfile mylog

5 The log output is as follows:

08:53:48 NOTE:  The Passport GDM is starting for myId (Date: 1996-06-03).
08:53:48 NOTE:  Command line: pgdm -auth PP_GROUP myId XXXX -modf modules 
-compf comps -logfile mylog
08:54:02 NOTE:  The PGDM Uploading is starting. Date: 1996-06-03.
08:54:21 NOTE:  Upload provisioning file 96052001.full.100 on EM NODE1.
08:54:25 NOTE:  The following component(s) will be propagated:
                Ac Userid/GUEST
08:54:25 NOTE:  The PGDM Uploading has completed successfully.

******** NODER2 - Processing/Error messages ********
08:54:28 NOTE:  The PGDM Propagation is starting for NODER2. Date: 1996-
06-03.
08:54:30 NOTE:  Preparing for provisioning.
08:54:52 NOTE:  Loading file 96052001.full.470 in the edit view on EM 
NODE2.
08:55:06 NOTE:  Checking the configuration.
08:56:10 NOTE:  Saving the configuration.
08:56:33 NOTE:  Changes saved in file 96052100.full.473 on EM NODE2.
08:56:42 NOTE:  The PGDM Propagation has completed successfully.

******** NODE3 - Processing/Error messages ********
08:56:44 NOTE:  The PGDM Propagation is starting for NODE3. Date: 1996-
06-03.
08:56:46 ERROR: EM NODE3 is not accessible under group PP_GROUP
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08:56:46 NOTE:  The PGDM Propagation has completed but errors were found.

******** LOG SUMMARY ********
   NODE2                         - Completed successfully.
   NODE3                         - Error found.
   08:57:45 NOTE:  Passport GDM has completed but errors
   were found.
========================================================================

Example 2: Propagating components
Propagate all Vncs components (see “Vncs hierarchy” (page 140) for the 
Vncs hierarchy) specified in the Committed view from Passport NODER10 
to NODER20 and NODER21. Use the Keyed NMS provisioning view. The 
pgdm command is as follows:

pgdm -auth <Group name> <UserId> <password> \

   -modf modules -compf vncs -logfile vncs_log

where:

modules is the name of the module name file. The file contains the 
following lines:

-source NODER10 -uploadmode COM
-target NODER20 NODER21 -uploadmode K NMS \
-downloadmode K NMS

vncs is the name of the component file. The file contains the following line:

Vncs/*

Processing and error messages are captured in the vncs_log log file.

Removing components during propagation
The components on a target Passport node can be deleted during global data 
propagation. The on-switch provisioning delete commands are specified in 
the pre-propagate command file.

1 Follow steps 1 to 3 of “Propagating components” (page 144).

2 Create a pre-propagate command file (see “Pre-propagate command file 
(optional)” (page 141)).
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3 Invoke pgdm with the -pcmdf option (see “The Global Data Manager 
command line” (page 141)).

For example, NODER20 and NODE21 both have Vncs/11 and Vncs/12, but 
the source (NODE10) does not have these components. You can remove the 
Vncs/11 and Vncs/12 from the target’s provisioning view by using the 
command file and the -pcmdf option. This command file contains the 
following lines:

del Vncs/11

del Vncs/12

Globally replacing attribute values
You can use pgdm to replace the attribute values for selected Passport nodes 
in the network.

1 Create a module name file. This file contains only target node records 
(see “Module name file” (page 137)).

2 Create a component file. This file contains the components and attribute 
values that you need to replace (see “Component file” (page 138)).

3 Invoke pgdm (see “The Global Data Manager command line” (page 141)).
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Using HP OpenView NNM desktop

This section describes how to access Configuration tools from the HP 
OpenView NNM desktop application. In this section, you can find the 
following information:

• “About HP OpenView NNM desktop” (page 149)

• “Configuration tools available from HP OpenView NNM desktop” 
(page 150)

• “Accessing HP OpenView NNM desktop from MDM” (page 150)

• “Accessing Configuration tools from HP OpenView NNM desktop” 
(page 150)

• “How HP OpenView NNM desktop displays Passport device names” 
(page 153)

• “Exiting HP OpenView NNM desktop” (page 153)

About HP OpenView NNM desktop
HP OpenView NNM desktop is an optional feature of Preside Multiservice 
Data Manager that runs on an HP OpenView platform. With this feature you 
can launch, from the HP OpenView NNM desktop, tools from the 
Configuration for Passport Devices toolset. Or, you can use the surveillance 
and configuration tools in the HP OpenView NNM desktop toolset.
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Configuration tools available from HP OpenView NNM 
desktop

See the following sections for information on the configuration tools that you 
can launch from HP OpenView NNM desktop:

• Nodal Provisioning. See 241-6001-610 Preside MDM Nodal 
Provisioning User Guide.

• Software Distribution and Configuration. See “Software Download and 
Configuration” (page 35).

• Service Integrity Simplification. See 241-6001-022 Preside MDM 
Network Reporting System User Guide.

• “Network Activation” (page 81).

• Passport/SNMP Devices Backup And Restore. See 241-6001-807 
Preside MDM Network Backup and Restore.

Accessing HP OpenView NNM desktop from MDM
Access HP OpenView NNM desktop from the Preside Multiservice Data 
Manager (MDM) Fault menu.

Accessing Configuration tools from HP OpenView NNM 
desktop

See the following procedures for information on how to start HP OpenView 
NNM desktop and access the Configuration tools:

• “Starting HP OpenView NNM desktop” (page 150)

• “Starting tools from the Configuration menu” (page 152)

• “Starting tools from the pop-up menu” (page 152)

Starting HP OpenView NNM desktop
1 In a UNIX window start HP OpenView:

/opt/OV/bin/ovw &

The About HP OpenView window opens. Click Close to close the window 
or wait for it to close on its own.

The Root map opens, displaying the Nortel Networks symbol and the IP 
Internet symbol. These symbols indicate the state of their respective 
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networks through color. The standard HP OpenView color scheme is 
used, as shown in the HP OpenView Display Legend.

The Event Categories window opens. It may display a status message at 
the bottom, stating the percentage of the trapd.log file that has been 
loaded.

2 To view your network on the Root map, double-click the Nortel Networks 
symbol.

The Nortel Networks submap opens and displays the devices in your 
network. The color of the icon indicates the states of the network devices. 
For Passport nodes, the icons let you distinguish between network 
elements belonging to the 6000, 7400 and 15000 series. 

• Icons depicting Passport legacy and 6000 nodes contains P6 or 6.

• Icons depicting Passport 7400 nodes contains P7 or 7.

• Icons depicting Passport 15000 nodes contains P15 or 15.

• Icons depicting unknown nodes contain P? or ?. Although the 
devices are in the database, it has not yet been configured to identify 
these devices. To change these icons to identify the device type, use 
the Make Configuration Data File (MCDF) utility. See 241-6001-015 
Preside MDM Network Model Administrator Guide for additional 
information on the MCDF utility.
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DPN devices are identified by a D or O.

3 Access the Configuration for Passport tools. There are two methods: see 
“Starting tools from the Configuration menu” (page 152) or “Starting tools 
from the pop-up menu” (page 152).

Starting tools from the Configuration menu
1 At the OVW submap, select a Passport node by clicking the left mouse 

button.

2 Select Passport from the Configuration menu.

3 Select the tool that you want to open. 

Starting tools from the pop-up menu
1 At the OVW submap, select a Passport node by clicking the left mouse 

button.
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2 Press the mouse menu button to display the node pop-up menu, and 
select Passport Configuration.

3 Select the tool that you want to open. 

How HP OpenView NNM desktop displays Passport device 
names

Passport node names are displayed on the Nortel Networks submap as EM/
<device_name>. For example, EM/EMDEV1

Note: The device name that appears on the Nortel Networks submap is 
the name with which the device is configured. Lowercase letters in a 
configured name appear as uppercase letters in the submap display.

Exiting HP OpenView NNM desktop
1 From the Root map or any submap, select Map -> Exit.

An OpenView Windows warning dialog opens.

2 To continue the exit process, click OK.

The dialog closes along with the Event Categories window and any open 
submaps.
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